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1 Overview 

TCI settings are organized in two clusters: 

• general settings control mapping between Teamcenter and 3DEXPERIENCE, for example 

custom attribute mapping or state mapping 

• administration settings control infrastructure configurations, for example server connection 

definitions for Teamcenter and 3DEXPERIENCE 

Settings are stored in two XML files in the XCI_HOME directory: 

• XCISettings.xml contains the general settings 

• XCIAdminSettings.xml contains the administration settings 

This reference lists the settings for each category.  
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2 General Settings 

The file XCISettings.xml in XCI_HOME defines settings that control mapping between 

Teamcenter and 3DEXPERIENCE, for example custom attribute mappings, state mappings or which 

file types to export. 

It is divided into sections: 

• Conversion: contains mapping settings that affect both systems (e.g. mapping of Release 

status) 

• Pdm: settings for Teamcenter export or import 

• Teamcenter: specific settings Teamcenter 

• Enovia: specific settings for 3DEXPERIENCE 

• Features: enable or disable TCI features 

The next subchapters list settings available in these sections. 

2.1 Conversion 

2.1.1 DisablePdmImportSkipNotModified 

To disable the skipping the import of objects to Teamcenter which are not modified since the last 

import, it must be set to true. Default setting is false. 

<DisablePdmImportSkipNotModified>true</DisablePdmImportSkipNotModified> 

2.1.2 DummyProductData 

Define a placeholder ItemRevision that is imported into 3DEXPERIENCE for ItemRevisions excluded 

from Teamcenter export – see 2.1.4. 

<DummyProductData> 

    <Type>ItemRevision</Type> 

    <ID>MyDummy</ID> 

    <Revision>1</Revision> 

    <Name>Replace</Name> 

    <Description>DummyPart for ExclusionList</Description> 

    <Owner>Owner</Owner> 

    <String>Display String</String> 

</DummyProductData> 

2.1.3 ExclusionCATProductsListFile 

Define a list of objects for which the CATProduct files should be ignored for 3DEXPERIENCE import. 

See 2.1.4 for an example of an exclusion list file. 

<ExclusionCATProductsListFile> 

  C:\tmp\exclusioncplist.xml 
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</ExclusionCATProductsListFile> 

2.1.4 ExclusionListFile 

Define Items or ItemRevisions that should not be exported from Teamcenter. 

Set replaceWithDummy to true to replace excluded ItemRevisions with a placeholder ItemRevision 

defined in DummyProductData setting – see 2.1.2. The placeholder object will be imported into 

3DEXPERIENCE.  

Note: every excluded ItemRevision will be replaced with the same placeholder ItemRevision 

<ExclusionListFile replaceWithDummy=”false”> 

  C:\tmp\exclusionlist.xml 

</ExclusionListFile> 

Example for an exclusion list file: 

<?xml version="1.0" encoding="utf-8" standalone="yes"?> 

<EL> 

  <ItemRev> 

    <Id>000123</Id> 

    <Type>Design Revision</Type> 

    <Revision>1</Revision> 

  </ItemRev> 

  <Item> 

    <Id>000567</Id> 

    <Type>Design Revision</Type> 

   </Item> 

</EL> 

2.1.5 FolderNamingConcatenation 

Build the new folder name in Teamcenter from Root Folder Name, this setting, and the Folder 

Name. Disabled by default. 

<FolderNamingConcatenation enabled="true">_</FolderNamingConcatenation> 

2.1.6 HandleAuxFileAsMainFile 

Relevant for PDM to 3DX. True to handle auxiliary files (non-BOM CATParts) like main files -> Create 

Product and Rep3DAggr in XpdmXml. Relevant for e.g. users of CMIR2 CATIA Integration that use 

non-BOM CATParts. Default value is false. 

<HandleAuxFileAsMainFile>true</HandleAuxFileAsMainFile> 

2.1.7 IgnoreNon3DPartGeometries 

Enables the ignoring of geometries which are not 3DPart in 3DEXPERIENCE if enabled. Disabled 

by default. 
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<IgnoreNon3DPartGeometries enabled=”true” /> 

2.1.8 OverwriteReleasedWithForce 

True to update released objects if force is true. Disabled by default. 

<OverwriteReleasedWithForce>true</OverwriteReleasedWithForce> 

2.1.9 Part3DTypeList 

List of file types which should be imported as 3DPart product type to 3DEXPERIENCE, the default 

is 'CATPart'. 

<Part3DTypeList> 

  <Part3DType>CATPart</Part3DType> 

</Part3DTypeList> 

2.1.10 PartNumberMapping 

Modify part numbers when transferring by adding a prefix and / or suffix to the part number. This can 

be set in general for all types or type specific. Disabled by default. 

Note: when changed part number mapping is only used for new objects that have not been 

transferred yet. Previously transferred objects or new revisions of such objects will be transferred 

with the old mapping. 

• To3DXPrefix: prefix to add when transferring to 3DEXPERIENCE 

• To3DXPostfix: suffix to add when transferring to 3DEXPERIENCE 

• ToPDMPrefix: prefix to add when transferring to Teamcenter 

• ToPDMPostfix: suffix to add when transferring to Teamcenter 

For type specific mappings with TypeMapping: 

• set typePDM when transferring to 3DEXPERIENCE and specify the source Teamcenter type 

• set type3DX when transferring to Teamcenter and specify the source 3DEXPERIENCE type 

<PartNumberMapping enabled="true"> 

  <Default> 

    <To3DXPrefix>TCI_</To3DXPrefix> 

  </Default> 

  <TypeMapping typePDM="MyItemRevision"> 

    <Mapping> 

      <To3DXPrefix/> 

      <To3DXPostfix/> 

      <ToPDMPrefix/> 

      <ToPDMPostfix/> 

   </Mapping> 

  </TypeMapping> 

 <TypeMapping type3DX="MyPhysicalProduct"> 

   <Mapping> 

    ... 
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   </Mapping> 

  </TypeMapping> 

</PartNumberMapping> 

2.1.11 PdmExportValidation 

Define validation checks to run during Teamcenter export. Each check is disabled by default and 

must be enabled. The optional onlyWarning flag can be set to handle a check only as warning 

condition and continue processing. 

• AttributeCheck checks the maximum length of an exported attribute specified by 

maxlength. Optionally, the attribute value can be truncated if the maximum length is 

exceeded by setting the truncate flag. 

• InstanceNameCheck checks the uniqueness of instance names under a parent object. 

• FileRefCheck checks multiple use of the same File Ref from different objects. 

• FileNameCheck checks the uniqueness of file names in the files section. 

• ProductLeafRepresentationCheck checks the existence of an attached 

Representation at a Product node if the Product node is a leaf node. 

• RepNameCheck checks for duplicate representation names by checking ID Attribute in 

Rep3D, Drawing, Document, and GenericDocument object. 

• ValidateMainFileCount checks if more than one main file is attached. 

• ValidateMissingFileForDocument checks if a file for document is attached. 

• ValidateMultipleReferencedDocument checks if a document is referenced by more 

than one part. 

• ValidateMultipleRevisions checks if more than one revision of the same part is found. 

• ValidateIncorrectRevisionSequence checks if the revision sequence is correct. 

• InvalidCharactersObjectNameCheck: 3DEXPERIENCE does not allow certain set of 

characters for business object names. Validate object names and, if configured, replace them 

either all with the same string or configure specific replacement strings per invalid character. 

Enabled by default. Disallowed characters: \*$?"',;\n\r 

<PdmExportValidation> 

  <AttributeCheck enabled="true"> 

    <XType xname ="Product"> 

      <XAttribute xname="Description"  

                  mappingtype="DefaultCustomization" 

     maxlength="60" 

     truncate="true" /> 

    </XType> 

  </AttributeCheck> 

  <InstanceNameCheck enabled="true" /> 

  <FileRefCheck enabled="false" /> 

  <FileNameCheck enabled="false" /> 

  <ProductLeafRepresentationCheck enabled="false" onlyWarning="true" /> 

  <RepNameCheck enabled="true" /> 

  <ValidateMainFileCount enabled="true" /> 

  <ValidateMissingFileForDocument enabled="true" /> 

  <ValidateMultipleReferencedDocument enabled="true" /> 
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  <ValidateMultipleRevisions enabled="true" /> 

  <ValidateIncorrectRevisionSequence enabled="true" /> 

  <InvalidCharactersObjectNameCheck enabled="true"> 

    <InvalidCharacterReplacement invalidCharacter="$"  

                                 replaceWith="-#-" /> 

  </InvalidCharactersObjectNameCheck> 

</ PdmExportValidation> 

2.1.12 PdmImportValidation 

Define validation checks before Teamcenter import. 

• AttributeCheck checks the maximum length of an exported attribute specified by 

maxlength. Optionally, the attribute value can be truncated if the maximum length is 

exceeded by setting the truncate flag. 

• UnknownDocumentTypeStrategy defines the handling of unmapped document types 

during transfer. If there is no V6FileFormat mapping available for an exported file from 

3DEXPERIENCE, this setting will define how to handle Teamcenter import.  

o WARNING: Default. No unmapped files will be transferred. The transfer will finish in 

state “Warning” and more information can be found in the report. 
o ERROR: Unmapped files will cause the transfer to fail. No data will be transferred. 

o IMPORT: Unmapped files will be transferred using the settings in 

GenericDocumentFormat - see chapter 2.1.28 for more information. No warning 

or error will be reported. 

<PdmImportValidation> 

  <AttributeCheck enabled="true"> 

    <XType xname ="Product"> 

      <XAttribute xname="Description" 

     mappingtype="DefaultCustomization" 

     maxlength="60" 

     truncate="true" /> 

 </XType> 

  </AttributeCheck> 

  <UnknownDocumentTypeStrategy>WARNING</UnknownDocumentTypeStrategy> 

</ PdmImportValidation> 

2.1.13 PdmStatusUpdateHandling 

Set status to related objects on Teamcenter import that are not directly mapped from a 

3DEXPERIENCE object, for example Master forms, BOMView Revisions or Datasets. 

• sourceType: ItemRevision type for which additional objects are updated 

• targetRelation: if the secondary object is attached by a relation (e.g. IMAN_specification) 

• targetRelationAttribute: if the secondary object is attached by an object property 

• targetObjectType: type of the secondary object 

If specified relation and target object are found below the source object, then the target object status 

is mapped according to V6MaturityToPdmStatusMapping. If the target object type is not 

configured in V6MaturityToPdmStatusMapping, it is mapped based on the parent object. 
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<PdmStatusUpdateHandling enabled=”true”> 

  <AdditionalPdmStatusUpdate sourceType=”Design Revision” 

       targetRelationType="IMAN_master_form” 

       targetObjectType=”Design Revision Master” /> 

  <AdditionalPdmStatusUpdate   

    sourceType=”Design Revision” 

    targetRelationAttribute=”structure_revisions” 

    targetObjectType=”BOMView Revision” /> 

</PdmStatusUpdateHandling> 

2.1.14 PdmStatusToV6MaturityMappingList 

Define mapping from Teamcenter status to 3DEXPERIENCE maturity state for transferring objects 

to 3DEXPERIENCE. 

• v6maturity: target maturity in 3DEXPERIENCE 

• pdmTyp: for which Teamcenter type to apply on Teamcenter export 

• pdmstatus: source Teamcenter status 

This mapping can be switched on or off with the enabled flag. Disabled by default. 

<PdmStatusToV6MaturityMappingList enabled=”true”> 

  <PdmStatusToV6MaturityMapping v6maturity=”RELEASED” 

      pdmTyp=”Design Revision” 

                                pdmstatus=”TCM Released” /> 

</PdmStatusToV6MaturityMapping> 

2.1.15 PdmV6FileType 

Define mapping of exported files from Teamcenter to 3DEXPERIENCE representation type. 

• fileextension: specify file extension for which to apply this mapping, can contain wildcard 

* 

• doctype: Dataset type in Teamcenter from which the file is exported 

• fileformat: optional format of the representation for 3DEXPERIENCE import if 

fileextension is not the format (e.g. when fileextension contains wildcards) 

• aux: true if it is an aux Dataset, default is false 

• filenameSuffix: Suffix which is appended to filename on Teamcenter download. Can be 

used to differentiate files with the same name but belonging to different Dataset attached to 

the ItemRevision (e.g. ItemRevision geometry and drawing). 

Each V6Representation defines a RepresentationType and optionally a DerivedType. 

RepresentationType can be one of Drawing, Rep3D, Rep3DAndOriginalDocument, 

Product, ProductOrRep3D, Document, or GenericDocument. If representation type is not set, 

it must be defined with a customization implementation. 

<PdmV6FileType> 

  <V6Representation fileextension="CATPart" doctype="CMI2Part"> 

    <RepresentationType>Rep3D</RepresentationType> 

    <DerivedType>DirectModel</DerivedType> 
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  </V6Representation> 

  <V6Representation fileextension="CATProduct" fileformat="CMI2Product" 

doctype="CreoPart"> 

    <RepresentationType>Rep3D</RepresentationType> 

  </V6Representation> 

</PdmV6FileType> 

2.1.16 Projects 

Define mapping of Teamcenter projects to 3DEXPERIENCE collaborative space and user. The 

Projects section must include one DefaultProject that will be used when no other project 

mapping matches matches. 

Note: in Teamcenter objects can be assigned to multiple projects. Only the first project is considered 

for this mapping. 

• ProjectName: owning collaborative space in 3DEXPERIENCE 

• Organization: owning organization in 3DEXPERIENCE 

• Owner: owning user in 3DEXPERIENCE 

• LifeCycle: policy for created 3DEXPERIENCE objects, can be override by policy mapping 

(see 2.1.26) 

• Maturity: default 3DEXPERIENCE maturity for Teamcenter objects with status, can be 

overridden by maturity mapping (see 2.1.272.1.26) 

• optional default 3DEXPERIENCE maturity mappings, can be overridden by maturity mapping 

(see 2.1.27) 

o MaturityNoStatus: Teamcenter objects without status 

o DocumentMaturity: Teamcenter non-CAD datasets with status that will be 

imported as Document 

o DocumentMaturityNoStatus: Teamcenter non-CAD datasets without status that 

will be imported as Document 

o GenericDocumentMaturity: Teamcenter non-CAD datasets with status that will 

be imported as GenericDocument 

o GenericDocumentMaturityNoStatus: Teamcenter non-CAD datasets without 

status that will be imported as GenericDocument 

• optional default policy for created 3DEXPERIENCE objects, can be override by policy 

mapping (see 2.1.26) 

o DocumentLifeCycle: Teamcenter non-CAD datasets that will be imported as 

Document 

o GenericDocumentLifeCycle: Teamcenter non-CAD datasets that will be 

imported as GenericDocument 

<Projects> 

  <DefaultProject name="Default"> 

    <ProjectName>Common Space</ProjectName> 

    <Organization>Company Name</Organization> 

    <Owner>DemoDesigner</Owner> 

    <LifeCycle>VPLM_SMB_Definition_MajorRev</LifeCycle> 

    <Maturity>RELEASED</Maturity> 

    <MaturityNoStatus>IN_WORK</MaturityNoStatus> 
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    <DocumentLifeCycle>Document Release</DocumentLifeCycle> 

    <DocumentMaturity>RELEASED</DocumentMaturity> 

    <DocumentMaturityNoStatus>IN_WORK</DocumentMaturityNoStatus> 

    <GeneralDocumentLifeCycle> 

      Controlled Production Release Rev2 

    </GeneralDocumentLifeCycle> 

    <GeneralDocumentMaturity>Released</GeneralDocumentMaturity> 

    <GeneralDocumentMaturityNoStatus> 

      WIP 

    </GeneralDocumentMaturityNoStatus> 

  </DefaultProject> 

</Projects> 

2.1.17 RenameDuplicateInstanceNames 

Used to rename duplicate instance names. Duplicates will be renamed to the Object Id of the relation. 

The default setting is “false”. 

<RenameDuplicateInstanceNames>true</RenameDuplicateInstanceNames> 

2.1.18 RevisionCleanupForPdm 

Control behavior during revise in Teamcenter. 

If cleanChildren is enabled, all children are removed for new revisions of existing ItemRevisions 

during Teamcenter import. The default BVR type is view and can be configured by the bvrType 

attribute. Disabled by default. 

If cleanDocuments is enabled, all objects that are attached by one of the defined relations 

(ExpandRelationType) and belong to one of the listed types (ExpandType) are removed for new 

revisions of existing ItemRevisions during Teamcenter import. Disabled by default. 

<RevisionCleanupForPdm> 

  <cleanChildren enabled="true" bvrType="view" /> 

  <cleanDocuments enabled="true"> 

    <ExpandRelationType>IMAN_specification</ExpandRelationType> 

    <ExpandRelationType>IMAN_Rendering</ExpandRelationType> 

    <ExpandType>CMI2Part</ExpandType> 

    <ExpandType>CMI2Product</ExpandType> 

    <ExpandType>CMI2Drawing</ExpandType> 

    <ExpandType>DirectModel</ExpandType> 

  </cleanDocuments> 

</RevisionCleanupForPdm> 

2.1.19 SetTimeModified 

Control if modification date is written for XPDM import. Modification date controls whether data needs 

to be updated on 3DEXPERIENCE import or can just be referenced. Disabling write of modification 

date will update the object on every import. 



General Settings Conversion 

TCI Release 3.14 - Settings Reference 10 

By default, write of modification date is enabled. This can be disabled per class of 3DEXPERIENCE 

object: Rep3D, Drawing, Document, GenericDocument, ProductFile, Product, and 

ProductInst. 

This optimization can be disabled, e.g. to resolve multi model links in several contexts. 

<SetTimeModified enabled=”true”> 

  <Rep3D disabled ="true" /> 

  <Drawing disabled ="true" /> 

  <Document disabled ="true" /> 

  <GenericDocument disabled="true" /> 

  <ProductFile disabled="true" /> 

  <Product disabled="true" /> 

  <ProductInst disabled="true" /> 

</SetTimeModified> 

2.1.20 SharedFileTypeExtensions 

Control if 3D or Drawing representations are imported to 3DEXPERIENCE as aggregated or shared. 

By default, representations are imported as aggregated. 

For all file extensions specified a shared representation will be imported to 3DEXPERIENCE. 

<SharedFileTypeExtensions> 

 <SharedFileTypeExtension>model</SharedFileTypeExtension> 

 <SharedFileTypeExtension>cgr</SharedFileTypeExtension> 

 <SharedFileTypeExtension>CATDrawing</SharedFileTypeExtension> 

</SharedFileTypeExtensions> 

2.1.21 TimeModifiedExclusionListFile 

Define a list of objects for which modification date should be changed or removed. If 

removeTimeStamp flag is set, modification date is removed otherwise it will be reduced by two 

seconds. 

<TimeModifiedExclusionListFile removeTimeStamp="false"> 

  C:\tmp\exclusiontmlist.xml 

</TimeModifiedExclusionListFile> 

2.1.22 TypeMapping 

Define type mapping between 3DEXPERIENCE and Teamcenter object types to map custom 

types. Disabled by default. 

<TypeMapping enabled="true"> 

  <V6ToPdm> 

    <Mapping v6Type="VPMReference" pdmType="ItemRevision"/> 

    <Mapping v6Type=" VPMReference" pdmType="Design Revision"/> 

   </V6ToPdm> 

  <PdmToV6> 
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    <Mapping v6Type="VPMReference" pdmType="ItemRevision"/> 

    <Mapping v6Type=" VPMReference" pdmType="Design Revision"/> 

   </PdmToV6> 

</TypeMapping> 

2.1.23 UnitConversionDefinition 

Defines a list of conversions between different units to be applied during Teamcenter import or 

3DEXPERIENCE import. Attributes exported from the source system might not be exported in the 

unit which is displayed in the user interface. For example, in 3DEXPERIENCE an attribute with input 

unit “cm” is exported with unit “m”. 

Conversion calculation: new_value = old_value * multiplier + offset. 

The unit conversions are applied during import of custom attributes in Teamcenter or 

3DEXPERIENCE when the conversion is specified in the CustomAttributeMapping (see section 

for Teamcenter 2.2.4 and section 2.4.2 for 3DEXPERIENCE import). 

<UnitConversionDefinition> 

  <UnitConversionname="kelvinToFahrenheit" unit="F" > 

    <Multiplier>1.7999999999999985600000000000012</Multiplier> 

    <Offset>-459.66999999999923226400000000061</Offset>   

  </UnitConversion> 

  <UnitConversion name="FahrenheitToKelvin" unit="K" > 

    <Multiplier>0.555555555555556</Multiplier> 

    <Offset>255.372222222222</Offset> 

  </UnitConversion> 

</UnitConversionDefinition> 

2.1.24 UserMappingForPdm 

Transfer object ownership to new user and group during Teamcenter import.  

Warning: This can cause access problems if you want to transfer objects a second time to 

Teamcenter.  

If owner or group is not configured, the default Teamcenter behavior defines the owner. 

If AdditionalChangeOwnerObjectsForPdm is configured, all objects that are attached by one 

of the defined relations (ExpandRelationType) and belong to one of the listed types 

(ExpandType) will also be assigned to the Teamcenter owner and group. 

<UserMappingForPdm owner="user1" group="Engineering"> 

 <AdditionalChangeOwnerObjectsForPdm> 

  <ExpandRelationType>IMAN_specification</ExpandRelationType> 

  <ExpandRelationType>IMAN_master_form</ExpandRelationType> 

  <ExpandType>CMI2Product</ExpandType> 

  <ExpandType>ItemRevision Master</ExpandType> 

 </AdditionalChangeOwnerObjectsForPdm> 

</UserMappingForPdm> 
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2.1.25 V6CollaborativeSpaceToPdmProjectMapping 

Map 3DEXPERIENCE collaborative spaces to Teamcenter projects when transferring objects from 

3DEXPERIENCE to Teamcenter. Based on the owning collaborative space in 3DEXPERIENCE, one 

or multiple Projects can be assigned in Teamcenter. Disabled by default. 

If an object is already assigned to the mapped Project, the assignment operation is skipped. 

If removeFromNotMappedProjects is set, then objects will be removed from Projects in 

Teamcenter if the respective Projects is not mapped. Default is false. 

<V6CollaborativeSpaceToPdmProjectMapping enabled="true"     

    removeFromNotMappedProjects="true"> 

  <CollaborativeSpace name="TCI"> 

    <Project>ProjectA</Project> 

  </CollaborativeSpace> 

  <CollaborativeSpace name="Common Space"> 

    <Project>ProjectA</Project> 

    <Project>ProjectB</Project> 

  </CollaborativeSpace> 

</V6CollaborativeSpaceToPdmProjectMapping> 

2.1.26 V6LifecycleForPdmTypeMappingList 

Specify 3DEXPERIENCE policy when creating objects in 3DEXPERIENCE based on the source 

Teamcenter object type. 

• pdmtyp: source Teamcenter object type 

This mapping can be switched on or off with the enabled flag. Disabled by default. 

<V6LifecycleForPdmTypeMappingList enabled=”true”> 

  <V6LifecycleForPdmType pdmtyp=”ItemRevision”> 

    VPLM_SMB_Definition_MajorRev 

  </V6LifecycleForPdmType> 

  <V6LifecycleForPdmType pdmtyp=”Design Revision”> 

    VPLM_SMB_Definition_MajorRev 

  </V6LifecycleForPdmType> 

</V6LifecycleForPdmTypeMappingList> 

2.1.27 V6MaturityToPdmStatusMappingList 

Define mapping from 3DEXPERIENCE maturity state to Teamcenter status for transferring objects 

to Teamcenter. 

• v6maturity: source maturity in 3DEXPERIENCE 

• pdmTyp: for which Teamcenter type to apply on Teamcenter import 

• pdmstatus: which Teamcenter status to set 

This mapping can be switched on or off with the enabled flag. Disabled by default. 

<V6MaturityToPdmStatusMappingList enabled=”true”> 
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  <V6MaturityToPdmStatusMapping v6maturity=”RELEASED” 

      pdmTyp=”Design Revision” 

                                pdmstatus=”TCM Released” /> 

</V6MaturityToPdmStatusMappingList> 

2.1.28 V6PdmFileType 

Define which Files are imported to Teamcenter and their target Dataset type and relation type. There 

can be multiple V6FileFormat and ImportFormat blocks and a single 

GenericDocumentFormat block. 

Each V6FileFormat defines a Main section for mapping of aggregated 3DEXPERIENCE 

representations and an AUX section for mapping of shared 3DEXPERIENCE representations. 

Each ImportFormat block defines mapping for additional files besides the main geometry file that 

have been exported from 3DEXPERIENCE. For example, images for thumbnails or secondary 

geometry files, like .dxf file for .CATDrawing. 

GenericDocumentFormat defines, how unmapped document types will be handled, when the 

strategy is set to IMPORT (see chapter 2.1.11 for more details). 

Mapping options:  

• PdmDocType: Dataset type to create in Teamcenter 

• PdmDocRelation: name of relation between ItemRevision and Dataset 

• PdmRefType: type of named reference 

• RemoveOrigExtensionForPdm: true if the original file extension should be removed from 

the filename, e.g. rename the image myfile.CATPart.png to myfile.png. Default is false. 

• UseOrigFileNameForPdm: true to use the original filename as exported from 

3DEXPERIENCE. Default is false. 

• UseOrigFileNameForDocumentName: true to use the original filename as exported from 

3DEXPERIENCE for the Document created in Teamcenter. Default is false. 

<V6PdmFileType> 

  <V6FileFormat v6format="CATPart"> 

    <Main> 

      <PdmDocType>CMI2Part</PdmDocType> 

  <PdmDocRelation>IMAN_specification</PdmDocRelation> 

  <PdmRefType>CATPart</PdmRefType> 

     </Main> 

 <Aux> 

   <PdmDocType>CMI2AuxPart</PdmDocType> 

   <PdmDocRelation>IMAN_specification</PdmDocRelation> 

   <PdmRefType>CATPart</PdmRefType> 

 </Aux> 

  </V6FileFormat> 

  <ImportFormat fileFormat = "PNG" v6PdmType="Rep3D"> 

    <PdmDocType>Image</PdmDocType> 

    <PdmDocRelation>IMAN_specification</PdmDocRelation> 

    <PdmRefType>Image</PdmRefType> 

  </ImportFormat> 
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  <GenericDocumentFormat> 

    <PdmDocType>Text</PdmDocType> 

    <PdmDocRelation>IMAN_specification</PdmDocRelation> 

    <PdmRefType>Text</PdmRefType> 

  </GenericDocumentFormat> 

</V6PdmFileType> 

2.2 PDM 

2.2.1 Configuration 

Defines the model mapping from 3DEXPERIENCE to Teamcenter. 

name attribute on ModelMapping defines the model name from 3DEXPERIENCE. 

The Teamcenter ItemRevision configuration object can be defined statically with Item ID and 

Revision or dynamically with Item ID and Revision Rule UID. The configuration object is used to 

store the Variant Rules and Options. 

Set UpdateModel flag to update the configuration object with the configuration effectivity transfer. 

<Configuration> 

  <ModelMapping name="X021"> 

    <ItemId>X021-config</ItemId> 

    <Revision>A</Revision> 

  </ModelMapping> 

  <ModelMapping name="X120"> 

    <ItemId>X120-config</ItemId> 

    <RevisionRuleUid>QkqJD2AWr9tFBC</RevisionRuleUid> 

  </ModelMapping> 

  <UpdateModel>true</UpdateModel> 

</Configuration> 

2.2.2 CreatePartClass 

Name of the Teamcenter Item type to use.  

The default class is “Item”. This behavior can be changed by overwriting the 

com.tsystems.xci.customization.CustomPartType class. 

<CreatePartClass>Item</CreatePartClass> 

2.2.3 CreateFastenerPartClass 

Name of the Teamcenter Item type to use for Fastener items.  

The default is “WeldPoint”. This behavior can be changed by overwriting the 

com.tsystems.xci.customization.CustomItemType class. 

<CreateFastenerPartClass>WeldPoint</CreateFastenerPartClass> 
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2.2.4 CustomAttributeMapping 

Define custom type and attributes that are exported from Teamcenter or imported to Teamcenter. 

Disabled by default. 

A list of CustomObject definitions specifies the object types and their attributes. 

• type: Teamcenter object type 

• mappingtype: intermediate mapping type to / from which the Teamcenter object type is 

mapped 

• xname: 3DEXPERIENCE object class (Product, Rep3D, Drawing, Document, …) 

• createType: optional type of Teamcenter object to create when object with above 

mappingtype is first created in Teamcenter 

A CustomObject may contain multiple CustomAttribute. 

• name: Teamcenter name of the attribute 

• xname: intermediate mapping name of the attribute to / from which the Teamcenter attribute 

is mapped 

• type: attribute type, one of string, boolean, dateTime, double, duration, integer or 

positiveInteger 

• export: true to export this attribute from Teamcenter, default value is false 

• import: true to import this attribute from Teamcenter, default value is true 

• core: true if this attribute should be mapped to a XPDMXML standard attribute on export or 

from a standard attribute on import. Default value is false. 

• maxlength: maximum length of the attribute 

• truncate: true to truncate attribute value if maxlength is exceeded 

• defaultValue: set a default value on Teamcenter import if the attribute is empty 

• isNote: true when this attribute should be mapped to a Occurrence Note instead of an 

Occurrence attribute when mapping Instance attributes 

• unitConversionImport: to convert the attribute value to a different unit on Teamcenter 

import. Set attribute to name of a conversion as defined in UnitConversionDefinition 

(see 2.1.23). 

A CustomObject may contain CustomFormAttributes. 

• formtype: Teamcenter type of the form 

• relationname: name of relation that attaches form to object 

• may contain mutliple CustomAttribute as defined above 

<CustomAttributeMapping enabled="true"> 

  <CustomObject xname="Product" type="ItemRevision" 

      mappingtype="DefaultCustomization"> 

    <CustomAttribute xname="Description" 

                     name="object_desc"  

                     type="string"  

                     export="true"  

                     import="false" /> 

    <CustomFormAttributes formtype="ItemRevision Master"  

                          relationname="IMAN_master_form_rev"> 

      <CustomAttribute xname="Supplier Name"  

                       name="user_data_1"  
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                       type="string"  

                       export="true"  

                       import="true" 

                       maxlength="128" 

                       truncate="true" 

                       defaultValue="FavoriteSupplier" /> 

    </CustomFormAttributes> 

  </CustomObject> 

</CustomAttributeMapping> 

2.2.5 DocumentRelations 

Defines the relation types to be followed to Datasets when exporting from Teamcenter. 

<DocumentRelations> 

  <Relation>IMAN_specification</Relation> 

  <Relation>IMAN_Rendering</Relation> 

</DocumentRelations> 

2.2.6 DocumentRevisionSeparator 

In Teamcenter, the revision may be part of the dataset name. (e.g. 000123/B). If the dataset is copied 

with each revision, but the name changes to include the new revision (e.g. 000123/C), the mapped 

name in V6 would change as well. To get consistent naming, this separator can be defined. The 

dataset name will be split at the last occurrence of the configured separator and the revision will be 

discarded when naming the document in V6. 

<DocumentRevisionSeparator>/<DocumentRevisionSeparator> 

2.2.7 ExportWithStateFilter 

If enabled only objects with the configured state are exported from Teamcenter. The value is a 

comma separated list of allowed states. Disabled by default. 

<ExportWithStateFilter enabled="true"> 

  Frozen,Released 

</ExportWithStateFilter> 

2.2.8 GetMetadataSettings 

Define the attributes which are returned from the Show Teamcenter Attributes command in the TCI 

3DEXPERIENCE Rich Client. 

<GetMetadataSettings> 

  <!-- used as default for all ItemRevision with subclasses -->  

  <ResultAttributeNames pdmType="ItemRevision"> 

   <ResultAttributeName>item_id</ResultAttributeName> 

   <ResultAttributeName>item_revision_id</ResultAttributeName> 

   <ResultAttributeName>creation_date</ResultAttributeName> 
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   <ResultAttributeName>last_mod_date</ResultAttributeName> 

   <ResultAttributeName>object_type</ResultAttributeName> 

   <ResultAttributeName>object_name</ResultAttributeName> 

   <ResultAttributeName>object_desc</ResultAttributeName> 

   <ResultAttributeName>owning_user</ResultAttributeName> 

   <ResultAttributeName>owning_group</ResultAttributeName> 

   <ResultAttributeName>owning_site</ResultAttributeName> 

  </ResultAttributeNames> 

  <!-- used as default for all Document with subclasses -->  

  <ResultAttributeNames pdmType="Dataset"> 

    <ResultAttributeName>creation_date</ResultAttributeName> 

    <ResultAttributeName>last_mod_date</ResultAttributeName> 

    <ResultAttributeName>object_type</ResultAttributeName> 

    <ResultAttributeName>object_name</ResultAttributeName> 

    <ResultAttributeName>object_desc</ResultAttributeName> 

    <ResultAttributeName>owning_user</ResultAttributeName> 

    <ResultAttributeName>owning_group</ResultAttributeName> 

    <ResultAttributeName>owning_site</ResultAttributeName> 

  </ResultAttributeNames> 

  <!-- used for CMI2Part class -->  

  <ResultAttributeNames pdmType="CMI2Part"> 

    <ResultAttributeName>last_mod_date</ResultAttributeName> 

    <ResultAttributeName>object_name</ResultAttributeName> 

    <ResultAttributeName>object_desc</ResultAttributeName> 

    <ResultAttributeName>owning_user</ResultAttributeName> 

    <ResultAttributeName>owning_group</ResultAttributeName> 

  </ResultAttributeNames> 

</GetMetadataSettings> 

2.2.9 IgnoreRemoveNonExistingDocuments 

Disable the remove non existing document functionality. Default value is false. 

<IgnoreRemoveNonExistingDocuments> 

  true 

</IgnoreRemoveNonExistingDocuments> 

2.2.10 LinkedDrawingHandling 

Defines a list of Teamcenter drawing Dataset types which should be searched as referenced at 

ItemRevisions. The TCIC integration uses links for the drawing handling in Teamcenter.  

If LinkedDrawingHandling is enabled the integration searches for referenced drawings and 

transfers these drawings to 3DEXPERIENCE. Disabled by default. 

<LinkedDrawingHandling enabled="true"> 

  <LinkedDrawingDocumentType>CATDrawing</LinkedDrawingDocumentType> 

  <LinkedDrawingDocumentRelationType> 

       IMAN_external_object_link 
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  </LinkedDrawingDocumentRelationType> 

</LinkedDrawingHandling> 

2.2.11 LinkedRevisionHandling 

Defines a list of Teamcenter link types which should be used to search for referenced Item Revisions 

related to Documents. The TCIC integration uses links for the drawing handling in Teamcenter.  

If LinkedRevisionHandling is enabled the integration searches for referenced Item Revisions 

and transfers these Item Revisions to 3DEXPERIENCE. Disabled by default. 

<LinkedRevisionHandling enabled="true"> 

 <LinkType>IMAN_external_object_link</LinkType> 

</LinkedRevisionHandling> 

2.2.12 MetaUpdate 

The MetaUpdate section defines the Teamcenter and 3DEXPERIENCE attributes for the metadata 

update command. Disabled by default. 

MetaObject defines the Teamcenter type with the type attribute. The MetaAttribute defines 

the attributes for the update functionality. 

• name: the attribute name in Teamcenter. 

• v6name: the 3DEXPERIENCE attribute name 

With the MetaFormAttributes attached forms with attributes can be used for the meta update. 

The formtype defines the type of the form and the relationname defines the relation name 

between the ItemRevision and the Form. 

<MetaUpdate enabled="true"> 

  <MetaObject type="ItemRevision"> 

    <MetaAttribute name="object_name"   

                   v6name="attribute[PLMEntity.V_Name]"/> 

    <MetaFormAttributes formtype="ItemRevision Master"             

                        relationname="IMAN_master_form_rev"> 

      <MetaAttribute name="user_data_1" 

                     v6name="attribute[PLMEntity.V_description]"/> 

    </MetaFormAttributes> 

  </MetaObject> 

  <MetaObject type="Design Revision"> 

    <MetaAttribute name="object_desc"  

                   v6name="attribute[PLMEntity.V_description]"/> 

    <MetaAttribute name="object_name" 

                   v6name="attribute[PLMEntity.V_Name]"/> 

  </MetaObject> 

</MetaUpdate>  
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2.2.13 OverwriteOriginal 

Set to false to prevent overwriting of data originating from Teamcenter (after CLOC). Enabled by 

default. 

<OverwriteOriginal enabled="true" /> 

2.2.14 ReallyRemoveExistingNotProvided 

Setting whether to remove unknown occurrences in Teamcenter or not. Disabled by default. 

<ReallyRemoveExistingNotProvided enabled="true" /> 

2.2.15 RevisionQuerySettings 

Define settings for running Teamcenter ItemRevision Saved Queries. RevisionTypes defines list 

of object types to search for, use empty RevisionType for search all types. 

RevisionAttributeNames contains a mapping of Teamcenter Saved Query parameter name 

(User Entry Name) to object attributes. 

ResultAttributeNames lists which attributes should be returned. If empty, all attributes are 

returned.  

MaxResultToReturn specifies a maximum number of matches to be returned. Default value is 0, 

which means no limit. 

<RevisionQuerySettings> 

  <RevisionTypes> 

    <!-- Use empty RevisionType for search all types. --> 

    <RevisionType/> 

    <RevisionType>ItemRevision</RevisionType> 

    <RevisionType>Design Revision</RevisionType> 

    <RevisionType>Part Revision</RevisionType> 

  </RevisionTypes> 

  <!--  The RevisionAttributeName must be the "User Entry Name" in the  

        Saved Query definition of the Teamcenter Query Builder  

        application. For exmaple, for the item_id attribute it is "Item  

        ID" --> 

  <RevisionAttributeNames> 

    <RevisionAttributeName display="Item ID"> 

      Item ID 

    </RevisionAttributeName> 

    <RevisionAttributeName display="Item Revision"> 

      Revision 

    </RevisionAttributeName> 

    <RevisionAttributeName display="Name"> 

       Name 

    </RevisionAttributeName> 

    <RevisionAttributeName display="Description" > 

      Description 
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    </RevisionAttributeName> 

  </RevisionAttributeNames> 

  <!-- If ResultAttributeNames tag does not exist, then all not empty  

       attributes are returned. --> 

  <ResultAttributeNames> 

    <ResultAttributeName>item_id</ResultAttributeName> 

    <ResultAttributeName>item_revision_id</ResultAttributeName> 

    <ResultAttributeName>sequence_id</ResultAttributeName> 

    <ResultAttributeName>creation_date</ResultAttributeName> 

    <ResultAttributeName>owning_user</ResultAttributeName> 

    <ResultAttributeName>owning_group</ResultAttributeName> 

    <ResultAttributeName>last_mod_user</ResultAttributeName> 

    <ResultAttributeName>last_mod_date</ResultAttributeName> 

    <ResultAttributeName>checked_out_user</ResultAttributeName> 

  </ResultAttributeNames> 

  <MaxResultToReturn>25</MaxResultToReturn> 

</RevisionQuerySettings> 

2.2.16 StructureCompare3DXRevRuleUid 

Revision rule to use when expanding structure for comparison with 3DEXPERIENCE structure. 

<StructureCompare3DXRevRuleUid> 

  QokBHeBxZN8TTB 

<StructureCompare3DXRevRuleUid> 

2.3 Teamcenter 

2.3.1 ConfigurationImport 

Settings for the Option and Variant Rule import: 

• ConfigurationCreateItemType: the Item type to use for the creation of new Item 

configuration objects. Default is “Item 

• ConfigurationType:  

• RemoveExistingOptionValues: true to remove existion option values, default is false. 

• VariantRuleType: Variant Rule Type (VariantRule) to use when importing 3DX Variant 

Rules in Teamcenter, default is VariantRule. It must be set same as in Teamcenter 

Preference Cfg0CreateVariantRuleType. 

• VariantRuleRelationType: the variant rule relation type, default is IMAN_specification. 

• RevisionRuleForVariants: the Revision rule uid to use for option update.  

• RemoveOldVariantRule: true to remove old variant rules from the configuration object, 

default is true. 

• DeleteOldVariantRule: true to delete old variant rules, default is false. 

• SkipRemoveUnneedeBrackets: true to skip the removeUnneedeBrackets functionality, 

default is false 

• DummyOption: dummy option to add if the variant condition starts with a bracket 

o name: name of the dummy option 
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o value: value of the dummy option 

o vnItemId: VariantNode Item ID 

o itemId: Item ID to set to the Variant Condition Item ID field 

Settings for the Date Effectivity import: 

• OccurrenceEffectivityStartDateINF: the start date for INF values from 

3DEXPERIENCE, default is 1970-01-01. 

• OccurrenceEffectivityTimeZone: the ID for a TimeZone, either an abbreviation such 

as "PST", a full name such as "America/Los_Angeles", or a customID such as "GMT-8:00". 

• ProductConfiguratorNamespace: namespace when importing Families in Product 

Configurator data model. Default is 3DEXPERIENCE. 

<ConfigurationImport> 

  <ConfigurationCreateItemType>Item</ConfigurationCreateItemType>   

  <RemoveExistingOptionValues>false</RemoveExistingOptionValues> 

  <VariantRuleType>VariantRule</VariantRuleType> 

  <VariantRuleRelationType>IMAN_specification</VariantRuleRelationType> 

  <RevisionRuleForVariants>rev-rule-uid</RevisionRuleForVariants> 

  <RemoveOldVariantRule>true</RemoveOldVariantRule> 

  <DeleteOldVariantRule>false</DeleteOldVariantRule> 

  <SkipRemoveUnneedeBrackets>false</RemoveExistingOptionValues> 

  <OccurrenceEffectivityStartDateINF> 

    1970-01-01 

  </OccurrenceEffectivityStartDateINF> 

  <OccurrenceEffectivityTimeZone>MET</OccurrenceEffectivityTimeZone> 

  <ProductConfiguratorNamespace> 

    3DEXPERIENCE 

  </ProductConfiguratorNamespace> 

</ConfigurationImport> 

2.3.2 WorkingGroup 

Name of TCI working group in Teamcenter. Item Revisions owned by 3DEXPERIENCE will be 

moved to this group. 

<WorkingGroup>V6Group</WorkingGroup> 

2.4 Enovia 

2.4.1 Configuration 

Define settings for the configuration data import to 3DEXPERIENCE, for example the default revision 

when creating a new Model in 3DEXPERIENCE. 

All settings are optional and have default values. 

• DefaultModelVersionRevision: revision string for creating Model Version in 

Configuration import to 3DEXPERIENCE. Default revision is START. 

• EnableDeallocateVariant: true to enable the deallocation of not existing Variants in 

3DEXPERIENCE. Disabled by default. 
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• EnableDeallocateVariantValue: true to enable the deallocation of not existing Variant 

values in 3DEXPERIENCE. Disabled by default. 

• ModelConfigurationSeparator: separator between Model name and Product 

Configuration when importing Product Configuration into 3DEXPERIENCE. Default 

separator is -. 

• ModelVariantSeparator: separator between Model name and Variant name when 

importing Variants into 3DEXPERIENCE. Default separator is -. 

• VariantValueSeparator: separator between Variant name and Variant value when 

importing Variants into 3DEXPERIENCE. Default separator is -. 

<Configuration> 

  <DefaultModelVersionRevision>START</DefaultModelVersionRevision> 

  <EnableDeallocateVariant>false</EnableDeallocateVariant> 

  <EnableDeallocateVariantValue>false</EnableDeallocateVariantValue> 

  <ModelConfigurationSeparator>-</ModelConfigurationSeparator> 

  <ModelVariantSeparator>-</ModelVariantSeparator> 

  <VariantValueSeparator>-</VariantValueSeparator> 

</Configuration> 

2.4.2 CustomAttributeMapping 

Define custom type and attributes that are exported from 3DEXPERIENCE or imported to 

3DEXPERIENCE. Disabled by default. 

A list of CustomObject definitions specifies the object types and their attributes. 

• type: 3DEXPERIENCE object type 

• mappingtype: intermediate mapping type to / from which the 3DEXPERIENCE object type 

is mapped 

• xname: 3DEXPERIENCE object class (Product, Rep3D, Drawing, Document, …) 

A CustomObject may contain multiple CustomAttribute. 

• name: 3DEXPERIENCE name of the attribute 

• extensionname: name of the attribute extension in 3DEXPERIENCE, if applicable 

• xname: intermediate mapping name of the attribute to / from which the 3DEXPERIENCE 

attribute is mapped 

• type: attribute type, one of string, boolean, dateTime, double, duration, integer or 

positiveInteger 

• export: true to export this attribute from Teamcenter, default value is false 

• import: true to import this attribute from Teamcenter, default value is true 

• core: true if this attribute should be mapped to a XPDMXML standard attribute on export or 

from a standard attribute on import. Default value is false. 

• basic: true if this 3DEXPERIENCE is a basic attribute not defined on an object type, for 

example type, description, physicalid. In ExportXpdm or ExportFiles mode these attributes 

will be exported from 3DEXPERIENCE. 

• maxlength: maximum length of the attribute 

• truncate: true to truncate attribute value if maxlength is exceeded 

• defaultValue: set a default value on Teamcenter import if the attribute is empty 
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• unitConversionImport: to convert the attribute value to a different unit on 

3DEXPERIENCE import. Set attribute to name of a conversion as defined in 

UnitConversionDefinition (see 2.1.23). 

• xpdmExposed: false to export attributes from 3DEXPERIENCE that are not exposed with 

XPDM interface. These attributes are only exported if TDXExportMode is set to 

ExportXPDM. 

CustomAttributeMapping may also contain attribute flags to control if pdm-cust-config mapping 

files are generated for XPDM import or export – createPdmCustConfigForExport and 

createPdmCustConfigForImport. These mapping files control which attributes are exported or 

imported when transferring objects through XPDM interface and are generated from the 

CustomAttributeMapping. Alternatively, you can supply existing pdm-cust-config files with 

PdmCustConfigFileImport and PdmCustConfigFileExport. 

Following example defines the V_versionComment attribute for export of VPMReference types. 

<CustomAttributeMapping enabled="true" 

                        createPdmCustConfigForExport="true" 

                        createPdmCustConfigForImport="true"> 

  <CustomObject xname="Product" type="VPMReference"   

                mappingtype="VPMReference"> 

    <CustomAttribute xname="V_versionComment" name="V_versionComment"  

                     type="string" export="true" 

                     extensionname="MyExtension" /> 

  </CustomObject> 

</CustomAttributeMapping> 

2.4.3 EnableNonCatiaExpand 

Is only relevant if the TDXExportMode is set to ExportFiles. 

If set to true all geometries are exported, else only 3DPart geometries are exported. 

Default setting is false. 

<EnableNonCatiaExpand>false</EnableNonCatiaExpand> 

2.4.4 ExportWithStateFilter 

If enabled only objects with the configured state are exported from 3DEXPERIENCE. The value is a 

comma separated list of allowed states. 

<ExportWithStateFilter enabled="true"> 

  FROZEN,RELEASED 

</ExportWithStateFilter> 

2.4.5 FileExportConfiguration 

The configuration for the FileExport (TDXExportMode is set to ExportFiles) can be configured 

with FileExportConfiguration settings. 
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The FileExportConfiguration can be used to disable the CATPart or CATDrawing export. Also, 

Thumbnails or neutral formats can be exported. For detailed information about the configuration see 

the documentation of the Export batch in the “Readme_TSI3DXBatch.txt” file. 

The ignoreError flag can be set to true to ignore error at file export and continue processing.. 

The 3DXML export and the XCAD export can set the enableAssemblyCaching attribute to true 

to enable the Assembly file caching at export. 

RestApiExport defines exports with the Rest API from 3DEXPERIENCE.  

• AssemblyExport: enableExport set to false will skip the assembly file (POWER’BY) export. 

ignoreError set to true will continue on error. 

• PartExport: enableExport set to false will skip the part file (POWER’BY) export. 

ignoreError set to true will continue on error. 

• DrawingExport: enableExport set to false will skip the drawing file (POWER’BY) export. 

ignoreError set to true will continue on error. 

<FileExportConfiguration> 

  <Source type="3DShape"> 

    <CATPart enableExport="false"/> 

    <Thumbnail enableExport="true" viewableSize="300">PNG</Thumbnail> 

    <XCAD enableExport="false" xCadFormat="wrl">VRML</XCAD> 

    <XCAD enableExport="false" >JT_COMFOX</XCAD> 

  </Source> 

  <Source type="VPMReference"> 

    <TDXML enableExport="false" /> 

  </Source> 

  <Source type="Drawing"> 

    <CATDrawing enableExport="false"/> 

    <Thumbnail enableExport="true" viewableSize="300">PNG</Thumbnail> 

    <Print enableExport="true"/> 

  </Source> 

  <RestApiExport enabled="true"> 

    <AssemblyExport enableExport="true" ignoreError="true"/> 

    <PartExport enableExport="true" ignoreError="false"/> 

    <DrawingExport enableExport="true" ignoreError="true"/> 

  </RestApiExport> 

</FileExportConfiguration> 

2.4.6 GetMetadataSettings 

Defines the attributes which are returned from the “Show 3DEXPERIENCE Properties” command in 

the TCI Teamcenter Rich Client. 

<GetMetadataSettings> 

  <ProductObject enoviaType="VPMReference"> 

    <AttributeName display="Type">type</AttributeName> 

    <AttributeName display="Name">name</AttributeName> 

    <AttributeName display="Revision">revision</AttributeName> 

    <AttributeName display="Vault">vault</AttributeName> 
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    <AttributeName display="Policy">policy</AttributeName> 

    <AttributeName display="State">current</AttributeName> 

    <AttributeName display="Created">originated</AttributeName> 

    <AttributeName display="Modified">modified</AttributeName> 

    <AttributeName display="Owner">owner</AttributeName> 

    <AttributeName display="Organization">organization</AttributeName> 

    <AttributeName display="Project">project</AttributeName> 

    <AttributeName display="External ID"> 

      attribute[PLMEntity.PLM_ExternalID]</AttributeName> 

    <AttributeName display="Title"> 

      attribute[PLMEntity.V_Name]</AttributeName> 

    <AttributeName display=""> 

      attribute[PLMEntity.V_description]</AttributeName> 

  </ProductObject> 

</GetMetadataSettings> 

2.4.7 OverwriteOriginal 

Disable to not overwrite original data (after CLOC) in 3DEXPERIENCE. Enabled by default. 

<OverwriteOriginal>false</OverwriteOriginal> 

2.4.8 QuerySettings 

The TCI integration inside Teamcenter provides an online query in 3DEXPERIENCE without 

changing the application. Based on the query result a data transfer from 3DEXPERIENCE to 

Teamcenter can be initiated.  

The corresponding configurations for the query in 3DEXPERIENCE are defined in the 

QuerySettings section. 

DefaultEnoviaRole and the DefaultEnoviaVault are used as defaults for the 

3DEXPERIENCE login. The configured values are presented in the 3DEXPERIENCE login dialog 

window and can be modified by the user. If no default values are configured, empty input fields are 

presented to the user. 

QueryLimit defines the maximum number of query results presented to the user. If more matching 

objects are available in 3DEXPERIENCE, an information message will appear inside the user 

interface. The default setting is “100”. 

QueryTypes defines a list of selectable object types for the 3DEXPERIENCE query. Each 

QueryType defines one 3DEXPERIENCE object type (3DEXPERIENCE internal type name). The 

display attribute defines the type name presented to the user. If no query type is configured, an 

empty input field is presented to the user. In this case, the user has to input the 3DEXPERIENCE 

internal type name, like “VPMReference”. 

QueryAttributes defines the 3DEXPERIENCE attributes, which will be presented in the result 

table. The order of the attributes in the result table is also defined here and corresponds to the 

attribute sequence. Each QueryAttribute defines one 3DEXPERIENCE attribute, e.g. 

“majorrevision”. The display attribute defines a corresponding name used in the results window, 

e.g. “Major Revision”. If the visible attribute is set to “false”, the 3DEXPERIENCE attribute will not 
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be visible inside the result window. The default for the visible attribute is “true”. If no query 

attributes are configured, a list of default attributes is used. 

<QuerySettings> 

  <DefaultEnoviaRole>VPLMProjectLeader.Company Name.Common 

Space</DefaultEnoviaRole> 

  <DefaultEnoviaVault>vplm</DefaultEnoviaVault> 

  <QueryLimit>200</QueryLimit> 

  <QueryTypes> 

    <QueryType display="Physical Product">VPMReference</QueryType> 

  </QueryTypes> 

  <QueryAttributes> 

    <QueryAttribute display="Identification code" visible="true"> 

      id 

    </QueryAttribute> 

    <QueryAttribute display="Type" visible="true"> 

      type 

    </QueryAttribute> 

    <QueryAttribute display="Name" visible="true"> 

      name 

    </QueryAttribute> 

    <QueryAttribute display="Revision" visible="true"> 

      revision 

    </QueryAttribute> 

    ... 

  </QueryAttributes> 

</QuerySettings> 

2.4.9 RemoveNon3DPartRep3D 

True to remove Rep3D/Rep3DInst and Rep3DAggr from the XPDM export which are not connected 

with a 3DPart. 

<RemoveNon3DPartRep3D>false</RemoveNon3DPartRep3D> 

2.5 Features 

Enable or disable features if not required by use case. For example, in case of unidirectional transfer 

from 3DEXPERIENCE to Teamcenter only, disable Teamcenter to 3DEXPERIENCE functionality. 

• SendTo3DX: transferring ItemRevisions to 3DEXPERIENCE. Default is enabled. 

• SendToPDM: transferring Physical Product to Teamcenter. Default is enabled. 

• FolderSendTo3DX: transfer Folders to 3DEXPERIENCE. Default is enabled. 

• BookmarkSendToPDM: transfer Bookmarks to Teamcenter (or legacy Engineering Folder if 

configured). Default is enabled. 

• ListTo3DX: transfer lists of ItemRevisions to 3DEXPERIENCE. Default is enabled. 

• ListToPDM: transfer lists of Physical Products to Teamcenter. Default is enabled. 
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• StructureCompare: compare transferred objects between Teamcenter and 

3DEXPERIENCE. Default is enabled. 

• ReviseIn3DX: revise transferred objects in 3DEXPERIENCE without transferring 

structure. Default is disabled. 

• MetaUpdateIn3DX: synchronize attributes from Teamcenter to 3DEXPERIENCE without 

transferring structure. Default is disabled. 

• Query3DXPhysicalProduct: search for Physical Products in 3DEXPERIENCE. Default 

is enabled. 

• Query3DXBookmark: search for Bookmarks (or legacy Engineering Folders) in 

3DEXPERIENCE. Default is enabled. 

• Query3DXConfiguration: search for Models in 3DEXPERIENCE. Default is disabled. 

• ConfigurationExportFrom3DX: export of variant management dictionaries (Model, 

Model Version, Variants, Options) and effectivities. Default is disabled. 

• QueryPDMPartRevision: search for ItemRevisions in Teamcenter. Default is enabled. 

• QueryPDMPart: search for Items in Teamcenter. Default is enabled. 

• QueryPDMFolder: search for Folders in Teamcenter. Default is enabled. 

• QueryPDMConfiguration: search for Variant Rules in Teamcenter. Default is disabled. 

• ConfigurationExportFromPDM: export of Variant Conditions, Options and Variant 

Rules. Default is disabled. 

• DetailsServlet: show Teamcenter or 3DEXPERIENCE object details based on object 

UID in Tools -> Details. Default is disabled. 

• FileCacheInfoServlet: show file cache entries in Tools ->File Cache. Use maxReturn 

to control how many results are shown. Default is disabled. 

• JobServlet: show information about submitted jobs in Tools -> Job. Default is disabled. 

• TableInfoServlet: query TCI Product and Document table in Tools -> Table Info. 

Default is disabled. 

<Features> 

 <SendTo3DX enabled="true"/> 

 <SendToPDM enabled="true"/> 

 <FolderSendTo3DX enabled="true"/> 

 <BookmarkSendToPDM enabled="true"/> 

 <ListTo3DX enabled="true"/> 

 <ListToPDM enabled="true"/> 

 <StructureCompare enabled="true"/> 

 <ReviseIn3DX enabled="false"/> 

 <MetaUpdateIn3DX enabled="false"/> 

 <Query3DXPhysicalProduct enabled="true"/> 

 <Query3DXBookmark enabled="true"/> 

 <Query3DXConfiguration enabled="false"/> 

 <ConfigurationExportFrom3DX enabled="false"/> 

 <QueryPDMPartRevision enabled="true"/> 
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 <QueryPDMPart enabled="true"/> 

 <QueryPDMFolder enabled="true"/> 

 <QueryPDMConfiguration enabled="false"/> 

 <ConfigurationExportFromPDM enabled="false"/> 

 <DetailsServlet enabled="false"/> 

 <FileCacheInfoServlet enabled="true" maxReturn="50"/> 

 <JobServlet enabled="true"/> 

 <TableInfoServlet enabled="true"/> 

</Features> 
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3 Administration settings 

The file XCIAdminSettings.xml in XCI_HOME defines administration settings for the integration, 

for example connection parameters to Teamcenter and 3DEXPERIENCE. 

It is divided into sections: 

• Administration: settings defining integration behavior 

• Pdm: settings for Teamcenter behavior 

• Teamcenter: specific settings Teamcenter 

• Enovia: specific settings for 3DEXPERIENCE 

• XciWeb: settings for the TCI web client 

• Scheduler: settings for scheduling automated processes 

• TSI3DXBatch: configuration of 3DEXPERIENCE import and export batch utility 

• COMReconV5: configuration of CATIA V5 pre- and postprocessing 

• COMReconNX: configuration of NX preprocessing 

• FileConversion: configuration of file conversion batches 

The next subchapters list settings available in these sections. 

3.1 Administration 

3.1.1 CleanupPersistentDir 

True to clean up the persistent directory when the content is successfully transferred. Disabled by 

default. 

<CleanupPersistentDir>true</CleanupPersistentDir> 

3.1.2 CleanupReportDirDaysToKeep 

Define how many days to keep the reports in the Report directory. Default is -1 meaning results are 

kept indefinitely. 

<CleanupReportDirDaysToKeep>30</CleanupReportDirDaysToKeep> 

3.1.3 ConversionServerLoadBalancer 

Control behavior for the Conversion Server load balancer.  

• Timeout: timeout in seconds to wait for a free Conversion Server if all are in use. If timeout 

is reached, without receiving a free Conversion Server, the process is terminated with error. 

Default is 0 meaning unlimited timeout. 

• Taskkill: command to kill running processes on CS when processes are canceled. 

Enabled by default and default command is “taskkill /F /PID ___PID___” where ___PID___ 

represents the system process ID. 

<ConversionServerLoadBalancer> 

  <Timeout>3600</Timeout> 
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  <Taskkill enabled=”true”> 

    <Command>taskkill /F /PID ___PID___</Command> 

  </Taskkill> 

</ConversionServerLoadBalancer> 

3.1.4 Customizations 

The behavior of the integration can be modified using customization points. The Customizations 

tag may contain multiple CustomizationPoints defining which customization implementation 

should be used. Each CustomizationPoint defines a custpoint to be overridden and an 

entrypoint specifying the overriding implementation. The optional attribute enabled has the 

default true. 

If you require any kind of customization, please contact the support team. 

<Customizations> 

  <CustomizationPoint  

    custpoint="com.tsystems.xci.customization.CustomizationPointX" 

    entrypoint="my.customization.MyCustomizationPointImpl" /> 

</Customizations> 

3.1.5 Database 

TCI makes use of a database to store and keep track of required data. The used database must be 

configured using the resource definition of the application server. TCI will read the resource defined 

as jdbc/xciDB.  

The resource must be configured at the Tomcat application server in 

<CATALINA_HOME>/conf/context.xml. The default resource can be overridden by defining 

the PersistenceUnitName. 

<Database> 

  <PersistenceUnitName>jdbc/myXciDB</PersistenceUnitName> 

</Database> 

Example resource definition for Oracle: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  

 auth="Container" driverClassName="oracle.jdbc.OracleDriver"  

 maxTotal="100" maxIdle="10" maxWaitMillis="-1" 

 url="jdbc:oracle:thin:@my.db-server-url.com:1521:orcl"  

 username="XCI"  

 password="XCI" /> 

Example resource definition for MS SQL: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  

 auth="Container"     

     driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

 maxTotal="100" maxIdle="10" maxWaitMillis="-1" 

 url="jdbc:sqlserver://my.db-server-url.com\SQLEXPRESS; 
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          databaseName=XCI"  

 username="XCI"  

 password="XCI" /> 

Example resource definition for H2: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  

 auth="Container" driverClassName="org.h2.Driver"  

 maxTotal="100" maxIdle="10" maxWaitMillis="-1"  

 url="jdbc:h2:C:\XCI\XCI_HOME\xciDB\xciDB;AUTO_SERVER=TRUE"  

 username="XCI"  

 password="XCI" /> 

 

If the resource is not defined at the application server, a local and file based H2DB will be created in 

XCI_HOME directory. 

3.1.6 DwcProductStructureExport 

Export product structure with DownwardComaptibilty batch (export CATPart and CATProduct files 

from 3DEXPERIENCE with one call). Disabled by default. 

<DwcProductStructureExport enabled="true" /> 

3.1.7 ImportPdm 

Strategy how to import the 3DEXPERIENCE structures to Teamcenter: 

• enableLevelSplitUp: true will enable the split up of the Teamcenter import in a level-

based import. Disabled by default. 

• enableLevelSetBased: true will enable the set-based approach for the import of one level. 

The level-based import will start at the deepest level nodes of the product structure and will 

first import these leave nodes, then the parent objects up to the top level are imported 

including the direct children. If enableLevelSetBased is set to true then the same levels 

are imported in one import process (using the set-based import), else each object is imported 

in its own import process. Disabled by default. 

• enableQueuing: true will enable the functionality to not handle the same part number in 

parallel running Teamcenter imports. Disabled by default. 

• timeoutQueuing: timeout for the import queuing in ms. Default value is 10 minutes. 

• enableLevelQueuing: true will enable the functionality to not handle the same part 

number in parallel running Teamcenter level imports. Disabled by default. 

• timeoutLevelQueuing: timeout for the import queuing in ms. Default value is 10 minutes. 

<ImportPdm enableLevelSplitUp="true"  

           enableLevelSetBased="false"  

           enableQueuing="false"  

           timeoutQueuing="600000"  

           enableLevelQueuing="true"  

           timeoutLevelQueuing="600000" /> 
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3.1.8 JobDatabaseRefreshInterval 

Interval to query the database for new transfer jobs in in ms. Default value is 5 seconds. 

<JobDatabaseRefreshInterval>10000</JobDatabaseRefreshInterval> 

3.1.9 JobReceiverComplexThreadPoolSize 

The size of the Job Receiver complex thread pool (used for folder or list transfers). Restart needed 

to use the new value. Default value is 3. 

<JobReceiverComplexThreadPoolSize>6</JobReceiverComplexThreadPoolSize> 

3.1.10 JobReceiverThreadPoolSize 

The size of the Job Receiver thread pool. Restart needed to use the new value. Default value is 5. 

<JobReceiverThreadPoolSize>10</ JobReceiverThreadPoolSize> 

3.1.11 JobRetrySeconds 

The number of seconds to wait for the Job retry if the job fails. 0 will disable the retry. Default is 30 

seconds. 

<JobRetrySeconds>0</JobRetrySeconds> 

3.1.12 JobSchedulingStrategy 

Strategy which selects the next Job to run. Whenever there is free capacity in the job queue, this 

strategy reads queued jobs from the database and determines the next to job to run. Supported 

strategies: 

• FIFO: jobs are run in a first-in, first-out fashion, i.e. jobs are sorted by creation date and the 

oldest jobs is selected to run. Default strategy. 

• RoundRobin: jobs are separated into buckets. TCI then alternates between the buckets 

whenever there is a job to run. Jobs are divided into 

o one bucket for all standard job submitted by client (web client, Teamcenter or 

3DEXPERIENCE client plugin) 

o one bucket for each complex jobs (List, Folder, …) – all child jobs of one complex job 

are grouped into the same bucket 

o one bucket for jobs started by the scheduler 

<JobSchedulingStrategy>RoundRobin</JobSchedulingStrategy> 

3.1.13 LegacyTransformationSupport 

Enables the support for legacy transformation in Teamcenter. Enabled by default. 

<LegacyTransformationSupport enabled="true" /> 
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3.1.14 PersistentDir 

Optional definition of a directory to be used by TCI to store persistent data. TCI must have read and 

write access to this directory.  

If the value is not defined the path <XCI_HOME>\persistent will be used. 

<PersistentDir>C:\persistent</PersistentDir> 

3.1.15 PdmDocumentRevisionMapping 

Defines the revision numbers in Teamcenter for 3DEXPERIENCE representations. 

If PdmDocumentRevisionMapping is configured, TCI will perform a direct assignment between 

the revisions of Teamcenter and 3DEXPERIENCE. As a result of this configuration, the revisions in 

Teamcenter or 3DEXPERIENCE may have gaps if only selected revisions are transferred. 

• alphabetical: revisions in Teamcenter are alphabetical (A, B, C, …) 

• numerical: revisions in Teamcenter are numerical (1, 2, 3, …) 

If the PdmDocumentRevisionMapping is not configured the next free revision/index will be used, 

based on TCI mapping. As a result, revisions in the target system are in the order in which they are 

transferred which may not be the order in the source system. 

<PdmDocumentRevisionMapping>alphabetical</PdmDocumentRevisionMapping> 

3.1.16 PdmRevisionMapping 

Defines the revision numbers in Teamcenter. 

If PdmRevisionMapping is configured, TCI will perform a direct assignment between the revisions 

of Teamcenter and 3DEXPERIENCE. As a result of this configuration, the revisions in Teamcenter 

or 3DEXPERIENCE may have gaps if only selected revisions are transferred. 

• alphabetical: revisions in Teamcenter are alphabetical (A, B, C, …) 

• numerical: revisions in Teamcenter are numerical (1, 2, 3, …) 

If the PdmRevisionMapping is not configured the next free revision/index will be used, based on 

TCI mapping. As a result, revisions in the target system are in the order in which they are transferred 

which may not be the order in the source system. 

<PdmRevisionMapping>alphabetical</PdmRevisionMapping> 

3.1.17 ProcessStatusMaxDuration 

The search period used to search for ProcessStatus information when retrieving process status from 

client plugins. Default value is P7D to retrieve info for the last seven days. 

<ProcessStatusMaxDuration>P7D</ProcessStatusMaxDuration> 
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3.1.18 ProcessStatusMaxReturn 

The maximum number of ProcessStatus information to return when retrieving process status from 

client plugins. Default value is 50. 

<ProcessStatusMaxReturn>50</ProcessStatusMaxReturn> 

3.1.19 ProcessStatusOnlySessionUser 

Filter the result of the ProcessStatus by the current session user when retrieving process status from 

client plugins. Enabled by default. 

<ProcessStatusOnlySessionUser>true</ProcessStatusOnlySessionUser> 

3.1.20 ResourceBalancer 

Limits concurrent use of resources across all Converter Server hosts. A resource can be licenses 

for example and is identified by a string.  

The resource must then be assigned to a batch type, see 3.7 for TSI3DXBatch, 3.8 for COMReconV5 

and 3.9 for file conversion. 

<ResourceBalancer> 

  <Resource name=”V6” maxParallel=”2” /> 

  <Resource name=”V5” maxParallel=”2” /> 

</ResourceBalancer> 

3.1.21 SetFilterIn3DX 

True to enable the functionality to set filter in 3DX when sending structure names. Enabled by default. 

<SetFilterIn3DX>true</SetFilterIn3DX> 

3.1.22 SkipRepWithoutFile 

True to remove Representations without file -> no document without file. Disabled by default. 

<SkipRepWithoutFile>false</SkipRepWithoutFile> 

3.1.23 TDXExportMode 

The 3DEXPERIENCE export mode can be configured. 

• ExportXPDM: export from 3DEXPERIENCE using the XPDMImportExportBatch utility. On 

Premise only. 

• ExportFiles: export from 3DEXPERIENCE using Matrix and DWC utility. On Premise 

only. 

• ExportDesign: export from 3DEXPERIENCE using web services and DWC utility. 

• ExportStepx: export from 3DEXPERIENCE using the Enterprise IP Exchange service. 

Cloud only. 
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Default value is ExportFiles. 

<TDXExportMode>ExportXPDM</TDXExportMode> 

3.1.24 TDXImportMode 

The 3DEXPERIENCE import mode can be configured. 

• ImportXPDM: import to 3DEXPERIENCE using the XPDMImportExportBatch utility. On 

Premise only. 

• ImportStepx: import to 3DEXPERIENCE using the Enterprise IP Exchange service. Cloud 

only. 

Default value is ImportXPDM. 

<TDXImportMode>ImportXPDM</TDXImportMode> 

3.1.25 TempDir 

Optional definition of a temporary directory to be used by TCI. TCI must have read and write access 

to this directory. 

If the value is not defined the path <XCI_HOME>\temp will be used. 

<TempDir>C:\temp</TempDir> 

3.1.26 UidAsFileName 

Define if filenames of files exported by Teamcenter should be renamed to their Teamcenter uid + 

file extension. Files in different datasets in Teamcenter may have the same filename which can lead 

to collisions. 

If the setting does not exist, no files will be renamed. 

If rename is true, then all files will be renamed except files with extension specified in 

ExcludeFileExtension. 

If rename is false, only files with extension specified in ExcludeFileExtension will be renamed. 

<UidAsFileName rename=”true”> 

  <ExcludeFileExtension>CATPart</ExcludeFileExtension> 

  <ExcludeFileExtension>CATProduct</ExcludeFileExtension> 

</UidAsFileName> 

3.1.27 XCIServerUrl 

URL of TCI integration webapp. Must be configured if distributed Conversion Server are used, so 

that they can communicate back to TCI. 

<XCIServerUrl>https://my-tci-server:8080/XCI</XCIServerUrl> 
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3.2 Pdm 

3.2.1 Dispatchers 

Definitions for optional dispatchers to use. Each dispatcher can be enabled separately. 

<Dispatchers> 

  <Dispatcher enabled="true"> 

    <DocumentType>CMI2Part</DocumentType> 

    <FileType>CATPart</FileType> 

    <Provider>TSYSTEMS</Provider> 

    <Priority>3</Priority> 

    <Servicename>cmitojt</Servicename> 

    <Type>ONDEMAND</Type> 

  </Dispatcher> 

  <Dispatcher enabled="true"> 

    <DocumentType>CMI2Drawing</DocumentType> 

    <FileType>CATDrawing</FileType> 

    <Provider>TSYSTEMS</Provider> 

    <Priority>3</Priority> 

    <Servicename>cmitopdf</Servicename> 

    <Type>ONDEMAND</Type> 

  </Dispatcher> 

</Dispatchers> 

3.2.2 ExpandChunkSize 

Define how many objects to expand per Teamcenter call. Default value is 1000. 

Warning: can affect the performance of the tool and die utilization of the Teamcenter server. 

<ExpandChunkSize>1000</ExpandChunkSize> 

3.2.3 FileDownloadChunkSize 

Define how many files to download per request using the Teamcenter FCS. Default value is 1. 

<FileDownloadChunkSize>1</FileDownloadChunkSize> 

3.2.4 FileUploadChunkSize 

Define how many files to upload per request using the Teamcenter FCS. Default value is 1. 

<FileUploadChunkSize>1</FileUploadChunkSize> 

3.2.5 GetPropertiesChunkSize 

Define for how many objects to retrieve properties per Teamcenter call. Default value is 1000. 

Warning: can affect the performance of the tool and die utilization of the Teamcenter server. 
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<GetPropertiesChunkSize>1000</GetPropertiesChunkSize> 

3.2.6 HoldConnectionOpenInSeconds 

Seconds to keep the Teamcenter service connection open while waiting for new service connection 

request. Default value is 60 seconds. 

<HoldConnectionOpenInSeconds>60</HoldConnectionOpenInSeconds> 

3.2.7 RefreshChunkSize 

Define how many objects to refresh per Teamcenter call. Default value is 1000. 

Warning: can affect the performance of the tool and die utilization of the Teamcenter server. 

<RefreshChunkSize>1000</RefreshChunkSize> 

3.2.8 ReportReceiverList 

Defines a list of Teamcenter users to receive reports on TCI transfers. The reports will be delivered 

through Teamcenter to the mailbox of the defined users. Enabled by default. 

<ReportReceiverList enabled="false"> 

  <Receiver>myTCIUser1</Receiver> 

  <Receiver>infodba</Receiver> 

</ReportReceiverList> 

3.2.9 SendJobNotifications 

Enable to send user a message in the Teamcenter Mail system after the Job is finished.  

<SendJobNotifications enabled="true"/> 

3.2.10 TemplateProductImport 

The location of the template product file to use on import. The product file will be added on 

Teamcenter imports. The location may be relative to the XCI_HOME directory or an absolute path. 

<TemplateProductImport enabled="true"> 

  TemplateProduct.CATProduct 

</TemplateProductImport> 

3.3 Teamcenter 

3.3.1 CMIRIICompatibility 

To support as most as possible environments TCI can be configured to run in CMI RII compatibility 

mode. This will modify the default behavior to match some specialties of the environment. 
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To switch on the CMI RII compatibility mode the following configurations must be set in the TCI 

configuration file in the Teamcenter section. 

Additionally, the following optional settings can be set: 

• HandleAuxForms: true to handle aux files for CMI RII, default is true 

<CMIRIICompatibility enabled=”true”> 

  <HandleAuxForms>true</HandleAuxForms> 

</CMIRIICompatibility> 

3.3.2 FileManagement 

If the useFsc is set to true, the tccs is not used, but the direct connection to the fsc is used. 

Define FileManagementUtility to use with parameters:  

• ClientIPAddress: This client's address which can be optionally used to determine the 

FSC assignments. 

• AssignedFSCURIs: Optional array of FSCs assigned to this client. These are passed in the 

form {"http://192.168.1.1:1234", "http://192.168.1.2:1234"}. These are configured in 

fmsmaster.xml as fscid and clientmap. 

• BootstrapFSCURIs: An array of bootstrap FSCs to get FSC assignments from. These are 

passed in the form {"http://192.168.1.1:1234", "http://192.168.1.2:1234"}. These are set as 

values for the preference FMS_Bootstrap_Urls and can be listed by running the command 

line utility backup_xmlinfo. 

This initialization can be a direct assignment of assigned FSCs URIs, or via a bootstrap procedure 

that queries the FMS system to find assigned FSCs based on the supplied client IP. Direct 

initialization is invoked by passing assignedFSCURIs. The FMS system is not queried for assigned 

FSCs. Bootstrap initialization is invoked by passing bootstrapFSCURIs and clientIPAddress. The 

bootstrap FSCs will be queried to get assigned FSCs for the given client IP. If the client IP is null or 

an empty string, the bootstrap servers will use the client address off the connection. Assigned FSCs 

are kept in the proxy and used by default on all other APIs. Optionally, specific FSCs to be used for 

a given API call by passing them in fscServerURIs. 

<FileManagement useFsc="true"> 

 <!-- ClientIPAddress is empty --> 

 <AssignedFSCURIs>http://fschost:fsc-port/</AssignedFSCURIs> 

 <!-- BootstrapFSCURIs is empty --> 

</FileManagement> 

3.3.3 LatestRevisionRuleUid 

The revision rule UID used to get the latest Revision. 

<LatestRevisionRuleUid>da12b3d4ef54gt</LatestRevisionRuleUid> 

3.3.4 MinimizeLoadProperties 

Enable to aggressively minimize loadProperties calls. Disabled by default. 
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<MinimizeLoadProperties enabled="true" /> 

3.3.5 PolicyName 

Name of Teamcenter SOA policy to use. 

<PolicyName>Default</PolicyName> 

3.3.6 PolicyPath 

File path to Teamcenter SOA policy definition file. 

<PolicyLocalPath>C:\TCI\TCI_PolicyFile.xml</PolicyLocalPath> 

3.3.7 ReportDatasetNamedRef 

Defines named reference type when storing reports in Teamcenter. Default value is Text. 

<ReportDatasetNamedRef>Text</ReportDatasetNamedRef> 

3.3.8 ReportDatasetType 

Defines dataset type when storing reports in Teamcenter. Default value is Text. 

<ReportDatasetType>Text</ReportDatasetType> 

3.3.9 Server 

Definition of the Teamcenter server and the login credentials for Teamcenter. 

• Url: Teamcenter 4-tier server URL 

• Username: username of Teamcenter user 

• Password: password for Teamcenter, encrypted by default (see installation manual for 

password encryption). Set plaintext flag to use password without encryption. 

• Group: group for connecting to Teamcenter 

• Role: role for connecting to Teamcenter 

• Locale: specify locale when connecting to Teamcenter, If not specified, default Teamcenter 

locale is used. 

• UseBypass: set bypass flag for user. Disabled by default. 

• WaitForWarmServer: define time to wait for a warm server in ms, default value is 5000 

• LoginRoleFailedCode: partial error code to reset group and role info for, default value is 

214102. 

<Server> 

  <Url>http://my.tc-server.url:8080/tc</Url> 

  <Username>myTCIUser</Username> 

  <Password plaintext="true">myTCIPassword</Password> 

  <Group></Group> 

  <Role></Role> 
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</Server> 

3.3.10 SessionPool 

Defines the Session Pool handling. The session pool holds connections to Teamcenter open and 

uses this connection to login and logout with the Teamcenter Server. 

▪ Sessions are created as needed.  

▪ If Login is not enabled logins will only be issued on new created connections, but not on 

previously suspended connections. The default setting is “true”. 

▪ If Logout is not enabled logouts without discarding the session are suppressed. The default 

setting is “true”. 

▪ If DiscardOnFailedLogin is enabled connections will be discarded when a TC session 

login fails on them otherwise not. The default setting is “true”. 

▪ When a new session (using the same server, user, group and role) is needed the dormant 

connection will be reused. 

▪ If DiscardIdle is enabled a cyclic check will be executed to log out sessions that are idle 

for the timeout defined in the setting. The default setting is “false”. 

▪ If DiscardUsed is enabled connection will be discarded after the defined number of virtual 

TC sessions has used the connection. The default setting is “false”. 

<SessionPool enabled="true"> 

  <Login enabled="false" /> 

  <DiscardOnFailedLogin enabled="false" /> 

  <Logout enabled="false" /> 

  <!-- 60 min session timeout (3600000) --> 

  <DiscardIdle enabled="true">3600000</DiscardIdle> 

  <DiscardUsed enabled="false">100</DiscardUsed> 

</SessionPool> 

3.3.11 TcICCompatibility 

To support as most as possible environments TCI can be configured to run in TcIC compatibility 

mode. This will modify the default behavior to match some specialties of the environment. 

To switch on the TcIC compatibility mode the following configurations must be set in the TCI 

configuration file in the Teamcenter section. 

Additionally, the following optional settings can be set: 

• OccurrenceProperty: default is “bl_occurrence_name” 

• OccurrenceNote: default is “catiaOccurrenceName” 

• BomLineOccurrenceProperty: default is “catiaOccurrenceName” 

• BomViewRevisionType: default is “catia” 

<TcICCompatibility enabled="true"> 

  <BomViewRevisionType>view</BomViewRevisionType> 

</TcICCompatibility> 
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3.4 Enovia 

3.4.1 BookmarkDisplayPattern 

Display pattern for Bookmark. Default setting is “{name}”. 

<BookmarkDisplayPattern>{name}</ BookmarkDisplayPattern> 

3.4.2 BulkOperation 

Specific operations can be parallelized by running multiple threads. Define how many threads can 

be started in parallel for: 

• VPMReferenceQueryParallelSize: query for VPMReference objects. Default is 1 

because ADK seems to serialize the queries and there would be a performance loss due to 

overhead. For REST / Cloud this should be set to a higher value (e.g. 20). 

<BulkOperation> 

 <VPMReferenceQueryParallelSize>1</VPMReferenceQueryParallelSize> 

</BulkOperation > 

3.4.3 CatiaV5ExportVersion 

The CATIA V5 version used to store the info in Teamcenter. 

<CatiaV5ExportVersion>V5R28</CatiaV5ExportVersion> 

3.4.4 ChildObjectExpandPattern 

Optional expand pattern for child part objects. Comma separated list of types. Default setting is 

“VPMReference”. 

<ChildObjectExpandPattern>VPMReference</ChildObjectExpandPattern> 

3.4.5 ChildRelationExpandPattern 

Optional expand pattern for child relations. Comma separated list of relation types. Default setting is 

“VPMInstance”. 

<ChildRelationExpandPattern>VPMInstance</ChildRelationExpandPattern> 

3.4.6 ConfigurationModelDisplayPattern 

Display pattern for Configuration Model. Default setting is “{name} {attribute[Marketing Name]}”. 

<ConfigurationModelDisplayPattern> 

  {name} {attribute[Marketing Name]} 

</ConfigurationModelDisplayPattern> 
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3.4.7 ConfigurationModelVersionDisplayPattern 

Display pattern for Configuration Model Version. Default setting is “{name} {attribute[Marketing 

Name]} {revision}”. 

<ConfigurationModelVersionDisplayPattern> 

  {name} {attribute[Marketing Name]} {revision} 

</ConfigurationModelVersionDisplayPattern> 

3.4.8 Customization 

Definition of the customization to use in XPDM events. This customization must be defined in the 

pdm-cust-config.xml in the 3DEXPERIENCE installation. 

The com.tsystems.xci.customization.CustomTypeMapping customization class can 

overwrite this setting. 

<Customization>DefaultCustomization</Customization> 

3.4.9 DocumentDisplayPattern 

Display pattern for documents. Default setting is “{name} {revision}”. 

<DocumentDisplayPattern>{name} {revision}</VPMReferenceDisplayPattern> 

3.4.10 ExportStep 

Settings for the Stepx export from 3DEXPERIENCE cloud by the Enterprise IP Exchange service. 

• ExportJobPollingSleepPeriod: time in milliseconds to wait between job result polling. 

Default is 10000 (10 seconds). 

• ExportJobMaximumDuration: time in minutes to wait for the job result. 0 or negative for 

infinite. Default is 60. 

<ExportStep> 

 <ExportJobPollingSleepPeriod>10000</ExportJobPollingSleepPeriod> 

 <ExportJobMaximumDuration>60</ExportJobMaximumDuration> 

</ExportStep> 

3.4.11 FolderConnectionDisplayPattern 

Display pattern for FolderConnections. Default setting is “{attribute[PLMEntity.PLM_ExternalID]}”. 

<FolderConnectionDisplayPattern> 

  {attribute[PLMEntity.PLM_ExternalID]} 

</FolderConnectionDisplayPattern> 

3.4.12 FolderDisplayPattern 

Display pattern for Folder. Default setting is “{attribute[PLMEntity.PLM_ExternalID]}”. 
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<FolderDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]}</FolderDispl

ayPattern> 

3.4.13 FileCache 

Defines the File Cache URL used to cache files for the export files mode. Disabled by default. 

<FileCache enabled="true"> 

  <XciFcUrl>http://my.tci-integration-server.url:port/XCI_FC</XciFcUrl> 

</FileCache> 

3.4.14 HoldConnectionOpenInSeconds 

Seconds to keep the 3DEXPERIENCE service connection open while waiting for new service 

connection request. The default value is 60. 

<HoldConnectionOpenInSeconds>60</HoldConnectionOpenInSeconds> 

3.4.15 HTTPClient 

Define HTTP connection settings when connecting to 3DEXPERIENCE: 

• ConnectionRequestTimeout: timeout in milliseconds when requesting a connection from 

connection pool. Default: 15000. Set to 0 for no timeout and to negative to use system default. 

• ConnectTimeout: timeout in milliseconds until connection is established. Default: 15000. 

Set to 0 for no timeout and to negative to use system default. 

• SocketTimeout: timeout in milliseconds between two consecutive data packages. Default: 

50000. Set to 0 for no timeout and to negative to use system default. 

<HTTPClient> 

  <ConnectionRequestTimeout>15000</ConnectionRequestTimeout> 

  <ConnectTimeout>15000</ConnectTimeout > 

  <SocketTimeout>50000</SocketTimeout> 

</HTTPClient> 

3.4.16 ImportPowerBy 

Enable to activate 3DEXPERIENCE import in POWER'BY mode. Data will be imported in native V5 

format into 3DEXPERIENCE and can then be loaded using the Dassault POWER'BY Integration of 

3DEXPERIENCE and V5. Disabled by default. 

<ImportPowerBy enabled="true" /> 

3.4.17 ImportStep 

Settings for the Stepx import to 3DEXPERIENCE cloud by the Enterprise IP Exchange service. 

• ImportCompanyName: company name for the STEP header. Default is "T-Systems 

International GmbH". 

• ImportCompanyId: company id for the STEP header. Default is "www.t-systems.com". 
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• ImportJobPollingSleepPeriod: time in milliseconds to wait between job result polling. 

Default is 10000. 

• ImportJobMaximumDuration: time in minutes to wait for the job result. Default is 30. 

• ImportJobMaximumDurationResultsInError: true to set the job result to success if it 

runs longer than the ImportJobMaximumDuration. Default is true.  

• EnableNon3DPartGeometryImport: true to enable the import of non 3DPart geometries, 

e.g. cgr, V4 model. 

<ImportStep> 

  <ImportCompanyName>My Company name</ImportCompanyName 

  ... 

</ImportStep> 

3.4.18 MappingContextName 

The mapping context name to use, used to find the correct mapping in 3DEXPERIENCE. 

<MappingContextName>XPDM<MappingContextName> 

3.4.19 RepObjectExpandPattern 

Optional expand pattern for representation objects. Comma separated list of types. Default setting 

is “VPMRepReference”. 

<RepObjectExpandPattern>VPMRepReference</RepObjectExpandPattern> 

3.4.20 RepRelationExpandPattern 

Optional expand pattern for representation relations. Comma separated list of relation types. Default 

setting is “VPMRepInstance”. 

<RepRelationExpandPattern>VPMRepInstance</RepRelationExpandPattern> 

3.4.21 RestApiUseOneSearchField 

True to use only one untyped search field for the 3DEXPERIENCE search in the web client. 

<RestApiUseOneSearchField>true</RestApiUseOneSearchField> 

3.4.22 RootBookmarkDisplayPattern 

Display pattern for Root Bookmark. Default setting is “{name}”. 

<RootBookmarkDisplayPattern>{name}</RootBookmarkDisplayPattern> 

3.4.23 RootFolderDisplayPattern 

Display pattern for Root Folder. Default setting is “{attribute[PLMEntity.PLM_ExternalID]}”. 

<RootFolderDisplayPattern> 
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  {attribute[PLMEntity.PLM_ExternalID]} 

</RootFolderDisplayPattern> 

3.4.24 SecurityContextTranslation 

The TCI Teamcenter client plugin provides a 3DEXPERIENCE login enhancement to select a 

security context in 3DEXPERIENCE based on Role, Organization, and Collaborative space. The 

display values for Role, Organization and Collaborative Space can be configured to translate internal 

names to user friendly ones. 

<SecurityContextTranslation> 

 <Role name="VPLMAdmin" display="Administrator"/> 

 <Role name="VPLMCreator" display="Author"/> 

 <Role name="VPLMExperimenter" display="Contributor"/> 

 <Role name="VPLMProjectAdministrator" display="Owner"/> 

 <Role name="VPLMProjectLeader" display="Leader"/> 

 <Role name="VPLMViewer" display="Reader"/> 

 <Role name="VPLMSecuredCrossAccess" display="Public Reader"/> 

 <Role name="VPLMAdmin" display="Administrator"/> 

</SecurityContextTranslation> 

3.4.25 Server 

Define 3DEXPERIENCE server connection. Parameters may be different for On Premise or Cloud 

deployment. 

Connecting to On Premise: 

• webServiceOnly: flag to connect only with web services. Disabled by default. 

• SpaceUrl: 3DSpace URL 

• PassportUrl: 3DPassport URL 

• Username: username for connecting to 3DEXPERIENCE 

• Password: password for connecting to 3DEXPERIENCE, encrypted by default (see 

installation manual for password encryption). Set plaintext flag to use password without 

encryption. 

• SecurityContext: Security Context for connecting to 3DEXPERIENCE provided as 

Role.Organization.CollaborativeSpace (e.g. VPLMProjectLeader.Company Name.Common 

Space) 

• Vault: optional, vault to set on connection 

• Use3DPassport: optional, false if connecting to internal 3DSpace. Enabled by default. 

• Environment: optional, 3DEXPERIENCE to use when connecting with batch utilities. 

Default value is UnifiedTyping. 

Connecting to Cloud: 

• webServiceOnly: flag to connect only with web services. Must be set to true. 

• SpaceUrl: 3DSpace URL 

• PassportUrl: 3DPassport URL 

• Username: username for connecting to 3DEXPERIENCE 
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• Password: password for connecting to 3DEXPERIENCE, encrypted by default (see 

installation manual for password encryption). Set plaintext flag to use password without 

encryption. 

• SecurityContext: Security Context for connecting to 3DEXPERIENCE provided as 

Role.Organization.CollaborativeSpace (e.g. VPLMProjectLeader.Company Name.Common 

Space) 

• Tenant: must be set to the Cloud tenant ID 

• ExchangeUrl: optional, URL of Enterprise IP Integration framework, must be set 

exchanging Stepx with the Cloud. 

• Language: optional, language in which attribute names are returned by 3DEXPERIENCE 

web services. Default language is en. 

• IndexSearchRetryCount: optional, number of retries when creating Variant and Options 

in case they are not indexed yet. Set flag firstRetryDelay to delay first retry in 

milliseconds (default is 10000). Set flag interval to define interval between retries in 

milliseconds (default is 60000). 

• Environment: optional, 3DEXPERIENCE to use when connecting with batch utilities. 

Default value is UnifiedTyping. 

Example for connection to On Premise 3DEXPERIENCE: 

<Server webServiceOnly=”false”> 

 <SpaceUrl>https://space-server.url:port/3dspace</SpaceUrl> 

     <PassportUrl> 

       https://passport-server.url:port/3dpassport 

      </PassportUrl> 

 <Username>user</Username> 

 <Password>XXX</Password> 

 <SecurityContext> 

       VPLMProjectLeader.Company Name.Common Space 

     </SecurityContext> 

 <Vault>vplm</Vault> 

</Server> 

3.4.26 SessionTimeout 

Defines the timeframe of inactivity in the 3DEXPERIENCE session before a relogin is done in the 

next operation in the session. Default value is 30 minutes. 

<SessionTimeout enabled="true">30</SessionTimeout> 

3.4.27 UseBookmark 

True to use Bookmark class for Folder functionality. Default is false. 

<UseBookmark>true</UseBookmark> 
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3.4.28 UseBookmarkRestApi 

True to use the Bookmark Rest API for bookmark import (UseBookmark must be true). Default is 

false. 

<UseBookmarkRestApi>true</UseBookmarkRestApi> 

3.4.29 VPMReferenceDisplayPattern 

Display pattern for VPMReference (Physical Products). Default value is 

“{attribute[PLMEntity.PLM_ExternalID]} {revision} {attribute[PLMEntity.V_Name]}”. 

<VPMReferenceDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]} 

{majorrevision}</VPMReferenceDisplayPattern> 

3.5 XciWeb 

3.5.1 AdminPassword 

Admin password for TCI web client. For password encryption, please see installation manual. 

Password must be encrypted by default. 

<AdminPassword plaintext="true">XXX</AdminPassword> 

3.5.2 MaxDBReturnNumber 

The maximum number of objects returned for the DB queries. Default value is 25. 

<MaxDBReturnNumber>50</MaxDBReturnNumber> 

3.5.3 MaxQueryReturnNumber 

The maximum number of objects returned for the 3DEXPERIENCE and Teamcenter queries. Default 

value is 25. 

<MaxQueryReturnNumber>50</MaxQueryReturnNumber> 

3.5.4 SessionTimeout 

The session timeout in seconds used for the TCI web client. Default timeout is 1800 seconds. 

<SessionTimeout>2000</SessionTimeout> 

3.5.5 UseFluid 

Use full display width for TCI web client. Disabled by default. 

<UseFluid>true</UseFluid> 
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3.6 Scheduler 

Scheduler can be used to automatically run processes at defined intervals. Disabled by default. 

• ThreadPoolSize: initializes the size of the Scheduler thread pool. Default is 5, minimum is 

3. A restart is needed to use the new value. 

• StartupDelay: defines the startup delay for tasks without startTime setting in seconds. 

Default is 60 seconds. 

• TaskList: list of tasks to run. TCI includes two tasks, HandleReleasedPdmObjects and 

HandleReleasedEnoviaObjects, which are described in following sections. 

<Scheduler enabled="true"> 

  <ThreadPoolSize>5</ThreadPoolSize> 

  <StartupDelay>120</StartupDelay> 

  <TaskList> 

    <Task>...</Task> 

    ... 

  </TaskList> 

</Scheduler> 

TaskList contains a list of Task objects to be run with the scheduler. 

Task contains a list of common control flags and a set of TaskSetting specific for each task. 

• enabled: true to run the task. 

• name: unique name of the Task. 

• loadClass: class to use which implements task logic 

• startTime: the start time of the task, e.g. "14:12:00". 

• period: the period in seconds to wait for next start of the task. 

• type: the scheduler type FixedRate or FixedDelay 

o FixedRate: enabled first after the given initial delay, and subsequently with the given 

period. 

o FixedDelay: enabled first after the given initial delay, and subsequently with the 

given delay between the termination of one execution and the commencement of the 

next. 

3.6.1 HandleReleasedPdmObjects 

The HandleReleasedPdmObjects task queries for objects with a defined state in Teamcenter. If 

the found revision is a new version of a formerly transferred object a new Transfer Job is initiated for 

this revision. 

The following TaskSetting are supported. 

• initialStartTime: initial start time if no further run of this task is known. 

• objectType: ItemRevision types to search for. 

• objectName: object name to search for 

• itemId: item id pattern. 

• statusList: list of status to search for. 

• projectId: list of project ID’s to search for. 
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• revRuleName, revRuleUid, force, removeExistingNotProvided, and 

withGeometricalConversion, are the settings for the created Jobs. 

o revRuleName: Revision Rule name, empty for default. 

o revRuleUid: Revision Rule UID, empty for default. 

o force: true to disable skip functionality 

o removeExistingNotProvided: true to remove existing children in 

3DEXPERIENCE. 

o withGeometricalConversion: true to convert the imports to 3DEXPERIENCE. 

• waitForDesignJobs: true to wait for the Jobs to finish. 

• writeReport: true to write a report in the persistent directory 

The objectType, objectName, itemId, statusList, and projectId can contain multiple 

entries with the configured delimiting character in Teamcenter (Teamcenter default “;”). 

Example Task setting for HandleReleasedPdmObjects, start the task at 2:00 AM and repeat the 

task every 24h. 

<Task name="Teamcenter-Released" 

      startTime="2:00:00" 

      period="86400"  

      loadClass="com.tsystems.xci.scheduler.HandleReleasedPdmObjects"  

      type="FixedRate"> 

  <TaskSetting name="initialStartTime"> 

    2020-11-09T00:00:00.000Z 

  </TaskSetting> 

  <TaskSetting name="objectType"> 

    ItemRevision;Design Revision 

  </TaskSetting> 

  <TaskSetting name="itemId"></TaskSetting> 

  <TaskSetting name="statusList">TCM Released;Frozen</TaskSetting> 

  <TaskSetting name="revRuleName">Any Status; No Working</TaskSetting> 

  <TaskSetting name="revRuleUid">QoU5$iOt5wQEgB</TaskSetting> 

  <TaskSetting name="force">false</TaskSetting> 

  <TaskSetting name="removeExistingNotProvided">true</TaskSetting> 

  <TaskSetting name="withGeometricalConversion">true</TaskSetting> 

  <TaskSetting name="waitForDesignJobs">false</TaskSetting> 

  <TaskSetting name="writeReport">true</TaskSetting> 

</Task> 

3.6.2 HandleReleasedEnoviaObjects 

The HandleReleasedEnoviaObjects task queries for objects with a defined state in 

3DEXPERIENCE. If the found revision is a new version of a formerly transferred object a new 

Transfer Job is initiated for this revision. 

The following TaskSetting are supported. 

• initialStartTime: initial start time, if not provided the time of the first run is used. 

• objectType: revision types to search for (comma separated to search for multiple types). 

• objectName: title (V_Name) search pattern. 
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• plmExternalId: part number (PLMExternalId) search pattern. 

• statusList: list of status to search for (comma separated to search for multiple types). 

• collaborativeSpace: list of collaborative spaces to search for (comma separated to 

search for multiple types). 

• force, and removeExistingNotProvided, are the settings for the created Jobs. 

o force: true to disable skip functionality 

o removeExistingNotProvided: true to remove existing children in Teamcenter. 

• waitForDesignJobs: true to wait for the Jobs to finish. 

• writeReport: true to write a report in the persistent directory 

Example Task setting for HandleReleasedEnoviaObjects, start the task at 2:00 AM and repeat 

the task every 24h. 

<Task name="TDX-Released" 

      startTime="2:00:00" 

      period="86400"  

      loadClass="com.tsystems.xci.scheduler.HandleReleasedEnoviaObjects"  

      type="FixedRate"> 

  <TaskSetting name="initialStartTime"> 

    2020-11-09T00:00:00.000Z 

  </TaskSetting> 

  <TaskSetting name="objectType">VPMReference</TaskSetting> 

  <TaskSetting name="objectName"></TaskSetting> 

  <TaskSetting name="plmExternalId"></TaskSetting> 

  <TaskSetting name="statusList">FROZEN,RELEASED</TaskSetting> 

  <TaskSetting name="collaborativeSpace">Common Space</TaskSetting> 

  <TaskSetting name="force">false</TaskSetting> 

  <TaskSetting name="waitForDesignJobs">false</TaskSetting> 

  <TaskSetting name="writeReport">true</TaskSetting> 

</Task> 

3.7 TSI3DXBatch 

Define installation of TSI3DXBatch to run 3DEXPERIENCE utilities, for example for import or export 

of files. 

TSI3DXBatch installations can be distributed to multiple hosts. Each installation has following 

settings. 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as TCI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 

• sharedPersistentDir: true if Conversion Server and TCI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

• CatStartPath: defines path to CATSTART.exe 



Administration  settings TSI3DXBatch 

TCI Release 3.14 - Settings Reference 51 

• CatStartEnv: defines name of 3DEXPERIENCE environment file 

• CatStartDirEnv: defines directory where environment file is located 

• Username: username for connecting to 3DEXPERIENCE 

• Password: password for connecting to 3DEXPERIENCE, encrypted by default (see 

installation manual for password encryption). Set plaintext flag to use password without 

encryption. 

• SecurityContext: security context for connecting to 3DEXPERIENCE 

• LoginTicket: login ticket may be used instead of username, password and security 

context. If all are defined, login ticket is used. Encrypted by default (see installation manual 

for password encryption). Set plaintext flag to use login ticket without encryption. 

• JTV5: optional, path to script for convert exported CATIA files to JT after export 

• PrintTemplate: optional, path to template file for export of PDF for Drawings 

Supported TSI3DXBatch tasks are: 

• Cloc: transferring data mastership between Teamcenter and 3DEXPERIENCE 

• EffectivityExport: export effectivites from 3DEXPERIENCE 

• FileExport: export files from 3DEXPERIENCE using DownwardCompatibility, 

DataExchangePLMBatch, PLMPrintBatch or Export 3DXML. 

• FolderExport: export folders from 3DEXPERIENCE 

• FolderImport: import folders to 3DEXPERIENCE 

• MappingInfo: export coexistence mapping information from 3DEXPERIENCE 

• Revise: revise objects in 3DEXPERIENCE 

• SetFilter: import structure filter to 3DEXPERIENCE 

• XPDMExport: export structure with XPDM from 3DEXPERIENCE 

• XPDMImport: import structure with XPDM to 3DEXPERIENCE 

Each task can contain a Target with a list of Installation to limit execution of the specific task 

to specific installations. If no Target is specified, the task can run on all installations. 

They can also contain a Timeout in seconds after which processing is terminated with error. 

Some tasks have task specific options: 

• Cloc: 

o ContextName: coexistence mapping context name. Default value is XPDM. 

• FileExport: 

o BatchInactivityTimeout: terminate with error when DownwardCompatibility or 

DataExchangePLMBatch do not change anything in the working directory for 

specified number of seconds. 

o DownwardCompatibility: 

▪ Format: target CATIA V5 format, must match CATIAVRxx for R18 – R21 or 

CATIAV5-6Rxxx for 2012 or greater 

▪ GeometryType3D: export geometries with specification tree 

(AsSpecifications) or as solid body (Exact). Default: 

AsSpecifications. Note: “AsSpecifications” works only for the 

corresponding CATIA V5 version e.g., for 3DEXPERIENCE 2021x the CATIA 

V5 target version is CATIA V5-6R2021. Also, early 3DEXPERIENCE releases 

like GA may not support the export of CATIA V5 CATParts with specifications 

at all. To make sure please check first if the 3DEXPERIENCE batch option is 
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available: 

  
▪ TemplateCATPart: create CATParts based on a template CATPart. Must 

specify full path. 

▪ RetryGeometryExport: retry geometry export if export of a list of objects 

fails, to isolate the failed object and export all other objects. Set to true or 

false. 

▪ JT_ContinueOnError: continue exporting if JT generation fails. Set to true 

or false. 

▪ CreateJtForClass: create JTs only for these 3DEXPERIENCE object 

types. Separate multiple types with “,”. Types must be subtypes of 

PLMCoreRepReference. Default: 3DShape. 

▪ CATFileFormatForJt: create JTs only for these file formats of exported 

files (e.g. CATPart). Separate multiple formats with “,”. Default: CATPart. 

o DataExchangePLMBatch: 

▪ MaxXCadBatchObjects: restrict maximum number of objects for a single 

DataExchangePLMBatch call. Default: 200. 

▪ XCadInvalidCharacters: replace invalid characters with “_” when 

constructing filenames for exported files. Default: \/:*?"<>| and tab character. 

o Export3DXML: 

o RepresentationExport: export all representations (All), export 3DShapes (Yes) 

or export no representations (No). Default: Yes. 

o Format: export with (WithAuthoring) or without authoring information (ForReview). 

Default: WithAuthoring. 

o PropagateDepth: how many structure levels are included in the export: All, 1, 2, 3, 

… Default: All 

o CompatibilityMode: export 3DXML in compatibility mode: Yes or No. Default: 

Yes. 

o CompatibilityLevel: Specify compatibility level when exporting in compatibility 

mode: CompatibilityLevel2013x, CompatibilityLevel2020x. Only available from 2021x 

onwards. If defined, CompatibilityMode will be automatically set to YES. Default: 

none. 

• MappingInfo: 

o MappingInfoResult: All to export MappingInfo result to one file. Each for one 

result file for each mappinginfo entry in the input file. Default value is All. 

o MappingInfoExposed: TRUE to export only exposed mapping. FALSE to export 

exposed and internal mapping. Default value is TRUE. 

o ContextName: mapping context name. Default value is XPDM. 

• XPDMExport: 

o FileFormat3D: target CATIA V5 format for geometry export 
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o GeometryType3D: type of geometry to export. Exact transfers the authoring data, 

Tesselated transfers the visualization data, AsSpecifications exports all 

specifications information 

o FileFormat2D: target CATIA V5 format for 2D Drawing export 

o SiteId: defines mapping context. Default value is XPDM. 

o WithFiles: Yes to export files. No to not export files. IfModified to only export 

Modified Files. Default value is Yes. 

o WithDocuments: Yes to export non-CAD documents. No to not export non-CAD 

documents. Default value is Yes. 

o WithPLMParams: Yes to export PLM Parameter. No to not export PLMParameter. 

Default value is Yes. 

• XPDMImport: 

o SiteId: defines mapping context. Default value is XPDM. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 

When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Following example defines one local installation and one remote installation. Task specific options 

are configured for XPDMExport and FileExport. All other tasks run with default parameters.  

XPDMExport can only run on the remote installation and all other batch tasks can run on both 

installations. XPDMExport and FileExport tasks use resource V6 to globally limit usage with 

ResourceBalancer, all other not explicitly defined tasks are not limited. 

<TSI3DXBatch> 

  <InstallationList> 

    <Installation id="tsi3dxbatch-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"               

                  maxParallel="4"> 

      <CatStartPath> 

        C:\Program Files\DassaultSystemes\B426\win_b64\code\bin\ 

        CATSTART.exe 

      </CatStartPath> 

      <CatStartEnv>XCI_3DX_BATCH_Env</CatStartEnv> 

      <CatStartDirEnv> 

        C:\Program Files\T-Systems\XCI_3DX_BATCH_R2024x_V3.11.0.0\ 

        config 

      </CatStartDirEnv> 

      <LoginTicket plaintext="true">XXX</LoginTicket> 

    </Installation> 

    <Installation id="tsi3dxbatch-local" maxParallel="2"> 

      <CatStartPath> 

        C:\Program Files\DassaultSystemes\B426\win_b64\code\bin\ 

        CATSTART.exe 

      </CatStartPath> 

      <CatStartEnv>XCI_3DX_BATCH_Env</CatStartEnv> 

      <CatStartDirEnv> 

        C:\Program Files\T-Systems\XCI_3DX_BATCH_R2024x_V3.11.0.0\ 

        config</CatStartDirEnv> 
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      <LoginTicket plaintext="true">XXX</LoginTicket> 

    </Installation> 

  </InstallationList> 

     

  <XPDMExport resource="V6"> 

    <Target> 

      <Installation>tsi3dxbatch-cs-1</Installation> 

    </Target> 

    <FileFormat3D>CATIAV5-6R2024</FileFormat3D> 

    <GeometryType3D>AsSpecifications</GeometryType3D> 

    <FileFormat2D>CATIAV5-6R2024</FileFormat2D> 

  </XPDMExport> 

     

  <FileExport resource="V6"> 

    <DownwardCompatibility> 

      <Format>CATIAV5-6R2024</Format> 

      <GeometryType3D>asSpeCifIcation</GeometryType3D> 

    </DownwardCompatibility> 

  </FileExport> 

</TSI3DXBatch> 

3.8 COMReconV5 

Define installation of COMReconV5 and enable or disable Preprocessing or Postprocessing of 

CATIA V5 files. 

To enable, include V5ToV6Preprocessing or V6ToV5Postprocessing. To disable, omit the 

settings. 

COMReconV5 installations can be distributed to multiple hosts. Each installation has following 

settings: 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as TCI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 

• sharedPersistentDir: true if Conversion Server and TCI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

• COMReconPath: base installation path of COMReconV5 

V5ToV6Preprocessing or V6ToV5Postprocessing can contain a Target with a list of 

Installation to limit execution of the specific task to specific installations. If no Target is 

specified, the task can run on all installations. 

They can also contain a Timeout in seconds after which processing is terminated with error. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 
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When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Following example defines one local installation and one remote installation. 

V6ToV5Postprocessing can only run on the remote installation and V5ToV6Preprocessing 

can run on both installations. Both tasks use resource V5 to globally limit usage with 

ResourceBalancer. 

<COMReconV5> 

  <InstallationList> 

    <Installation id="comrecon-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"  

                  maxParallel="4">        

      <COMReconPath> 

        C:\TCI\COMReconV5\240613_COMReconV5_R34 

      </COMReconPath> 

    </Installation> 

    <Installation id="comrecon-local" maxParallel=”2”> 

      <COMReconPath> 

        C:\TCI\COMReconV5\240613_COMReconV5_R34 

      </COMReconPath> 

    </Installation> 

  </InstallationList> 

  

  <V5ToV6Preprocessing resource=”V5” /> 

  

  <V6ToV5Postprocessing resource=”V5”> 

    <Target> 

      <Installation>comrecon-cs-1</Installation> 

    </Target> 

    <Timeout>120000</Timeout> 

  </V6ToV5Postprocessing> 

</COMReconV5> 

3.9 COMReconNX 

Define installation of COMReconNX and enable or disable Preprocessing of NX files. 

To enable, include NXToV6Preprocessing. To disable, omit the settings. 

COMReconNX installations can be distributed to multiple hosts. Each installation has following 

settings: 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as TCI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 
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• sharedPersistentDir: true if Conversion Server and TCI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

• COMReconPath: base installation path of COMReconNX 

NXToV6Preprocessing can contain a Target with a list of Installation to limit execution of 

the specific task to specific installations. If no Target is specified, the task can run on all 

installations. 

They can also contain a Timeout in seconds after which processing is terminated with error. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 

When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Following example defines one remote installation. 

<COMReconNX> 

  <InstallationList> 

    <Installation id="comrecon-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"  

                  maxParallel="4">        

      <COMReconPath> 

        C:\TCI\COMReconNX\230731_COMReconNX_R2306 

      </COMReconPath> 

    </Installation> 

  </InstallationList> 

  

  <NXToV6Preprocessing /> 

</COMReconNX> 

3.10 FileConversion 

Define file conversion batches which can convert exported files after Teamcenter export to different 

formats. 

Batch installations can be distributed to multiple hosts. Each installation has following settings: 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as TCI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 

• sharedPersistentDir: true if Conversion Server and TCI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

ConversionTask specify a concrete conversion from an input format to an output format. 

• inputType: input format 

• outputType: output format 
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• onlyConvert: only convert the file and do not add it to the structure. Disabled by default. 

• acceptList: indicate if this task accepts a list of files as input instead of a single file. Default 

value is true. 

ConversionTask can contain a Target with a list of Installation to limit execution of the specific 

task to specific installations. If no Target is specified, the task can run on all installations. 

ConversionTask can contain a Timeout in seconds after which processing is terminated with 

error. 

ConversionTaskPowerBy are defined the same way as ConversionTask but indicate special 

task that are required by NX POWER’BY visualization file generation. These will not be called during 

the generic file conversion process step. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 

When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Input to a file conversion task is passed in environment variable XCI_CONVERT_INFO. This variable 

points to a text file where each line contains a mapping of input file path to output file path separated 

by pipe character “|”. The script should parse the input path, convert the file and write it to the output 

path. 

Following example defines two file conversion tasks to different output formats that run on different 

installations. 

<FileConversion> 

  <InstallationList> 

    <Installation id="cgrconv-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"             

                  maxParallel="4"> 

      <ConversionCommand>C:\TCI\cgrconv.bat</ConversionCommand> 

    </Installation> 

    <Installation id="jtconv-local" maxParallel=”2”> 

      <ConversionCommand>C:\TCI\jtconv.bat</ConversionCommand> 

    </Installation> 

    ... 

  </InstallationList> 

   

  <ConversionTaskDefinitions> 

    <ConversionTask resource="V5"  

                    inputType="CATPart"  

                    outputType="jt"  

                    onlyConvert="true"> 

      <Target> 

        <Installation>jtconv-local</Installation> 

      </Target> 

    </ConversionTask> 

         

    <ConversionTask resource="V5"  

                    inputType="CATPart"  
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                    outputType="cgr"  

                    onlyConvert="true"> 

      <Target> 

        <Installation>cgrconv-cs-1</Installation> 

      </Target> 

    </ConversionTask> 

    <ConversionTaskPowerBy inputType="prt" outputType="stp" 

                           onlyConvert="true"> 

      <Target> 

    <Installation>prtToStp</Installation> 

  </Target> 

    </ConversionTaskPowerBy> 

    <ConversionTaskPowerBy inputType="stp" outputType="cgr"  

                           onlyConvert="true"> 

      <Target> 

   <Installation>stpToCgr</Installation> 

  </Target> 

    </ConversionTaskPowerBy> 

  </ConversionTaskDefinitions> 

</FileConversion> 


